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Chapter 1. Overview 

This chapter presents introductory concepts about the Matrix software including an understanding of various run 
modes, screen variations between instruments and the intended scope of information contained in this manual. 

MATRIX SOFTWARE OVERVIEW 

The Matrix software used to run Revvity automated cell-counting instruments is shared by multiple product 
families such as Cellaca MX/PLX and Cellometer K2. In addition, default assays (identified with prefixes such as 
MX_, PLX_ or K2_) and report templates are included for all supported instrument types. Available assays and 
report templates for all instruments can be viewed in the Manage tab > Assays and Report Templates screens. 

Note: When entering setup details, only assays for your specific instrument type will be displayed for selection. 
After a count is complete, report templates used in the presentation of scan results will be dynamically adjusted 
based on instrument consumable format variations (i.e., whether running multiple samples or a single sample). 

Key elements in Matrix software functionality are described below: 

• Acquiring Sample Data − The Acquire tab > Setup and Preview options are sequential screens used to acquire 
sample data. After loading samples, entering setup details, selecting at least one well and then clicking the 
Preview button, you can preview live channel images and adjust instrument focus/fluorescent exposure for 
each channel. Clicking the Count button engages the camera to acquire sample images as specified by the 
selected assay, which are then processed by the Matrix imaging and pattern-recognition software to decluster, 
identify and count individual cells according to defined cell type parameters. 

• Analyzing Scan Results − The Data tab > Select, Results and Recount options are sequential screens used to 
analyze scan results. Once a result is selected, you can vary the image displayed by clicking available channel 
buttons (e.g., BR, FL1, FL2, etc.) appearing across the top of the Well View tab or by choosing another well. 
Data associated with the well appears below the image or can be viewed as a consolidated report including 
data from all wells by clicking the Summary tab. To fine-tune analysis of a scan result, click the Recount button 
and either select a new assay or click the View button for the current assay to edit parameters as necessary. 
You can also view Last Used Assay parameters which are provided for your reference. 

• Setting Up Auto Exports − The Matrix auto export feature allows you to select the Images (e.g., Raw Images 
and Colorized Images), Data (e.g., Well Level CSV, Object Level CSV and Object Level ACS) and Archive (e.g., 
Data Set) output file types to be exported for an assay after completion of scan analysis. In addition, ACS 
templates can be imported into the Matrix software and assigned to an assay. On export, data will auto 
populate into the specified ACS template and can launch De Novo Software FCS Express if Auto Open option is 
also selected and the application is installed. FCS Express is pre-installed on Cellaca PLX instruments. 

• Customizing Reports − The Matrix custom reporting feature allows you to assign and/or modify report 
templates to be used by assays when generating scan results. You can change the report template used for 
displaying Well View tab data and manage the Reports List associated with an assay. You can also enable up to 
five additional tabs or specify output file types (e.g., CSV, Excel, PDF and Word) to be automatically exported, 
opened or printed after completion of scan analysis.  
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• Managing Assays, Cell Types, ACS Templates and Report Templates − The Manage tab > Assays, Cell Types,  
ACS Templates and Report Templates options display lists of these entities currently loaded in your instrument 
system. From these screens you can import/export, rename, delete or show/hide an entity in its applicable list. 
For most entities you can also view, create or use locked entities as templates to create new ones. 

AVAILABLE SOFTWARE RUN MODES 

In scenarios where an Operating Computer cannot always remain connected to its instrument, you can run the 
Matrix software in multiple modes to continue your analysis of captured sample images. In addition, you can 
export scan results to an alternative computer (e.g., workstation or personal laptop on which the Matrix software 
has also been installed) and perform sample analysis in a different location. 

Note: Computers used to import and analyze scan result data when not connected to an instrument must meet 
minimum requirements (i.e., Processor, Memory and Operating System) as noted below to run Matrix software in 
Data Analysis or Simulated modes. See the user manual for your instrument regarding technical specifications. 

The following software Run Modes are available. 

Live Mode 

If the instrument and camera are physically connected to the Operating Computer 
via the Revvity-provided USB Connector Cable, the Live Mode Instrument Status icon 
is displayed in the right corner of the Header Bar. Clicking this icon displays a message 
box containing details. Click icon again to close message box. 

Running the software in Live mode is necessary when acquiring sample data.  
Some Acquire tab functionality (such as adjusting focus and fluorescent exposure) is not 
available unless the software is being run in Live mode.  

Data Analysis Mode    

If the instrument and camera are not physically connected to the Operating Computer  
or an alternative computer is being used to continue your analysis of captured sample 
images, the Data Analysis Mode Instrument Status icon is displayed in the right corner 
of the Header Bar. Clicking this icon displays a message box containing details. Click icon 
again to close message box.  

Simulated Mode  

If the instrument and camera are not physically connected to the Operating Computer,  
a Simulated Mode uses stored/simulated images to mimic camera functionality. 

Note: Simulated Mode is only available to Revvity Sales/Field Application Specialists to 
demonstrate and test instrument functionality. 
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MINIMUM COMPUTER REQUIREMENTS 

The following minimum requirements apply to Operating Computers used for running the Matrix software while 
connected to an instrument. Some instruments include a Revvity-provided Laptop which may be more advanced. 

For Cellaca MX and Cellometer K2  For Cellaca PLX 

• Windows 10 PC, 64-bit 
• Intel® Core i7, 2.0 GHz processor 
• 16 GB RAM  
• USB 3.0 Port (for MX)/USB 2.0 Port (for K2) 
• GPU NVIDIA P1000 (or equivalent) 
• Full HD Display Resolution: 1920 x 1080 pixels 

  

• Windows 10 Professional, 64-bit 
• Intel® Core i7, 2.1 GHz processor, 16 Cores 
• 32 GB RAM 
• USB 3.0 Port 
• GPU NVIDIA A2000 
• FHD+ Display Resolution: 1920 x 1200 pixels 

In addition, these requirements also apply to any alternative computer (e.g., workstation or personal laptop) used 
to run the Matrix software in Data Analysis mode (i.e., while not connected to an instrument). Scan results can be 
exported from the Operating Computer and imported onto an alternative computer for further analysis. 

MATRIX 21 CFR PART 11 MODULE OVERVIEW 

The Matrix software offers a 21 CFR Part 11 module that is compliant with the Code of Federal Regulations (CFR) 
Title 21 Part 11 − Electronic Records: Electronic Signatures published by the U. S. Food and Drug Administration 
(FDA). In summary, this module ensures that an organization’s use of electronic records and digital signatures in 
place of traditional paper-based documentation is in compliance with current FDA regulations.  

Key elements in Matrix 21 CFR Part 11 module functionality are described below: 

• Electronic Signatures are captured during the counting and analysis workflow using e-Sign/e-Unsign buttons 
and include the name of an authorized user, date/time when the signature was executed, reason for the 
action being performed and meaning of the signature (i.e., for the Review, Approval or Rejection of an action). 
If a user’s assigned role does not have permissions to approve count results, a supervisor can log in to e-Sign 
the record on behalf of the user. 

• Electronic Records are created as the result of linking electronic signatures to user actions ensuring that 
records have not been copied or falsified in any manner.  

• An Audit Trail provides assurance regarding the integrity of an electronic record and continually monitors all 
users performing actions, the type of actions performed, and the date/time associated with user actions.  

This module may be enabled for your instrument at time of purchase or implemented as an upgrade in the field by 
our Support team. See Chapter 9. Using the 21 CFR Part 11 Module starting on page 85 for a full description of 
module functionality. 

  



 Chapter 1. Overview 

8003394 Matrix Software User Manual Rev E  4 

UNDERSTANDING SCREEN VARIATIONS BETWEEN INSTRUMENTS 

As the Matrix software is shared by multiple product families (e.g., Cellaca MX/PLX and Cellometer K2), it must 
account for physical differences between instruments such as: 

• Display of consumable formats (i.e., multi-well plates vs. two single chambers/wells per slide) 
• Load process for consumables (i.e., clickable software buttons vs. physical insertion/removal process) 
• Preview focus controls (i.e., automatic internal focus vs. physical external knob) 
• Default nature of assays and report templates (i.e., running and reporting on multiple samples  

vs. a single sample, and specifying the number of images to be captured per well) 

To accommodate for these differences, variations appear in the Header Bar and Acquire tab screens, in default 
assay file names and in the display of generated reports based on the needs of each instrument. Although the 
visual presentation of these differences varies, the core functionality driving these tasks remains the same. 

Variations in Display of Consumable Formats 

The software display of consumable formats is presented in Well Details area of the Acquire tab > Setup screen.  

The Cellaca MX and PLX instruments use a multi-well plate as shown in Figure A, below while Cellometer K2 uses a 
chambered slide as shown in Figure B. The visualization of “wells” on the slide is depicted by Images Per Well (i.e., 
1, 4 or 8) to be captured during the scan, with each image representing a cross-section of the counting chamber. 
Although each slide contains two chambers, only one chamber can be inserted into the K2 instrument at a time. 

As the MX and PLX allow users to select wells (i.e., a process not required for K2 as only one chamber can be in the 
instrument at a time), this feature does not have an impact on the preview and/or counting process other than the 
visual presentation of multiple scan images compared to a single scan image presented for K2. 

For Cellaca PLX, the multi-well plate display shown in Figure C (shown on next page) varies to accommodate 
further instrument capabilities by allowing users to specify number of Images Per Well (i.e., 1 or 4) to be captured 
during the count. The Images Per Well Indicator depicts the selected number of images representing quadrants in 
each well. In addition, a slide holder is provided with the PLX that holds up to four low fluorescence slides as 
shown in Figure D, illustrating two wells per slide.  
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Variations in Load Process for Consumables 

For instruments that have a retractable stage (e.g., Cellaca MX/PLX), the Menu Bar across the top of the screen 
displays an Eject or Load button based on the current position of the stage. Users will need to eject the stage in 
order to load or remove consumable plates. The Eject button becomes disabled while instrument performs a count. 

No buttons are necessary for instruments that use a Sample Slot (e.g., Cellometer K2) as users can manually insert 
or remove consumable chambered slides from the slot located on the front of the instrument.  

Variations in Preview Focus Controls 

For instruments that use automatic internal focus (e.g., Cellaca MX/PLX), Focus controls are displayed while you 
are in the Acquire tab > Preview screen. You can use the Auto Focus button to perform automatic focus 
adjustment or the Coarse Focus/Fine Focus controls to move through the focal planes of sample cells. In addition, 
you can specify a numerical value for the vertical position of the objective lens.  

 For instruments that have a physical Focus Knob located on the right side of the instrument (e.g., Cellometer K2), 
users can slowly turn the knob to manually adjust sample focus. Once good focus has been achieved during initial 
setup, the instrument should perform most counting operations with only minor adjustments.  
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Variations in Default Assays/Report Templates 

Default assays and report templates that were common between instruments in previous releases have been 
optimized to accommodate for the display needs for specific instruments (i.e., whether you are running and 
reporting on multiple samples vs. a single sample). Although the core nature of these assays and report templates 
remains the same, minor variations exist in their presentation as noted below: 

• Default assay names include a prefix (e.g., “MX_” or “K2_”) to identify instrument type. 
• Default report templates are able to automatically adjust their presentation to display results from either 

multiple samples or a single sample based on your instrument type.  

ABOUT THIS USER MANUAL 

The intended scope of this Matrix Software User Manual is to provide full software-related details regarding shared 
functionality as it has been applied across multiple product families (e.g., Cellaca MX/PLX and Cellometer K2). This 
manual provides information on the following topics: 

• Matrix Overview and Screen Variations • Managing ACS Templates 

• Screen Elements and Home Tab • Managing Report Templates and RTs List 

• Acquire Tab Functionality • 21 CFR Part 11 Module Functionality 

• Data Tab Functionality • Contacting Support and Reporting Issues 

• Custom Reporting Functionality • Report Designer for WPF Reference 

• Managing Assays and Assays List • Software License Details 

• Managing Cell Types and Cell Types List  

For hardware-related details regarding the setup, safety, care and use of your instrument, refer to the specific 
User Manual and Quick Start Guide available for your instrument. 

The following Precaution Signifiers are used in conjunction with the  symbol in this user manual:  

IMPORTANT: Note indicating that to skip or move past <content_of_note> may result in  
improper functionality of the instrument. 

CAUTION: Note indicating that <content_of_note> may damage instrument to the point  
where it will no longer function as expected. 

WARNING: Note indicating that <content_of_note> may permanently damage instrument 
and cause personal injury or harm. 

How Screen Variations are Identified in this Manual 

As the Matrix software is shared by multiple product families, it must account for physical differences between 
instruments. To accommodate for these differences, screen variations are noted throughout this guide using 
instrument-specific sections introduced with a special statement that is highlighted in italic font and orange text. 
Be sure to choose the section containing information applicable to your instrument. 
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Chapter 2. Matrix Screen Elements 

This chapter describes launching the software and presents basic graphical user interface (GUI) screen elements. 

Note: Prior to launching the Matrix software, be sure to verify your system is set up as recommended in the 
unboxing and site preparation sections of the instrument’s User Manual, and that the Operating Computer and 
instrument are both connected/powered on. In addition, follow all equipment safety protocols while using the 
instrument and keep the area around it clean before, during and after operation.  

LAUNCHING THE MATRIX SOFTWARE 

If the Operating Computer being used is a touchscreen device, you can interact directly with the software GUI by 
tapping gently on-screen elements (e.g., tabs, drop-downs or buttons) using a finger or stylus. If you choose to use 
touchscreen functionality, the term “click” as it appears in this guide may be replaced with “tap” interchangeably. A 
USB mouse may also be connected. 

From desktop of Operating Computer, launch the Matrix software by double-clicking the Matrix icon.  
The instrument will run through a startup sequence that includes connecting it to the database and 
initializing the calibrations. The default screen for your instrument is displayed (e.g., the Cellaca MX 
Acquire tab > Setup screen is shown below).  

Note: If the Matrix 21 CFR Part 11 module has been enabled for your system, users must log in before they can use 
the software. See Chapter 9. Using the 21 CFR Part 11 Module starting on page 85 for module functionality.  

To confirm both the instrument and camera are connected to the software: 

1. Click the Instrument Status  icon (green “thumbs up”) located in the  
upper right corner of the screen. Text displayed indicates that the instrument  
and camera are connected to the Matrix software. 

2. Click the icon again to close the message box. 
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After initial setup of an instrument, it must be calibrated using the Matrix software prior to first-time use. You will 
be prompted with a message if you attempt to acquire data before calibration has been performed.  

The calibration process takes a background image that will be used to normalize the cell counter for each installed 
filter pair without a consumable counting plate loaded in the instrument. For assistance, contact Support by 
visiting https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

MATRIX SCREEN ELEMENTS 

Upon launching the Matrix software you are presented with a default screen for your instrument (e.g., the Acquire 
tab > Setup screen). Basic screen elements and their display variations between instruments are described below. 

Header Bar 

The Header Bar visible across the top of the screen is always displayed. Elements displayed in this bar may vary 
based on instrument type.  

Functionality of Header Bar elements is described below. 

    
Eject/Load Buttons: Controls movement of the instrument stage (either ejects stage 
from instrument or retracts stage into instrument for sample loading) so the counting 
plate or slide holder can be placed onto or removed from the stage. The Eject button 
becomes temporarily disabled while instrument performs the count process.  

Eject/Load buttons are displayed only for Cellaca MX/PLX instruments. 

  Instrument Status Icons: Displayed in the right corner of the Header Bar, indicates 
current instrument status. Clicking this icon displays a message box containing details. 
Click icon again to close the message box. 

• The Live Mode icon (green “thumbs up”) indicates that the instrument and 
camera are connected to the Matrix software. 

• The Data Analysis Mode icon (red “thumbs down”) indicates that the instrument 
and camera are not connected to the Matrix software. 

• The Simulated Mode icon (blue with an “S”) indicates that the instrument and 
camera are running in simulation mode. 

Note: Simulated Mode is only available to Revvity Sales/Field Application Scientists to 
demonstrate and test instrument functionality. 

 

Assay/Plate Names: Assay name and plate name are added to the Menu Bar when 
you proceed to the Preview screen in the count process. 

 

User ID and Logout Button: If the Matrix 21 CFR Part 11 module is enabled, displays 
the identity of the currently logged in user and Logout button.  

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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Navigation Bar 

The Navigation Bar visible on the left side of the screen contains tabs/screen names and is always displayed. 
Functionality associated with each tab is described below. Note that options displayed in the Acquire and Data 
tabs represent screens marking your progression through a sequential process, while options in the Manage tab 
may be individually selected to perform distinct tasks. 

 

Home Tab: Contains the                                                                       logo distinguishing 
the software from earlier versions used to run the instrument system.  

Also contains the About Matrix button which displays software version details and 
global Support hotlines, as well as the Generate Diagnostic Report/Clear All Logs 
buttons used to assist Support with troubleshooting technical issues. See Viewing 
Software Version on page 11 and Generating Diagnostic Reports on page 104. 

 

Acquire Tab: Contains the two sequential screens in the Data Acquisition workflow. 
For example, in the Acquire tab you must first enter Setup details before advancing 
on to Preview the sample and confirm focus/fluorescent exposure for each channel. 
As you move through screens in this workflow, the Navigation Bar status is updated 
to display the current screen. 

The Setup screen can be selected as an option if you decide to review your setup 
after previewing the sample. Once you are satisfied and proceed to performing the 
count, Navigation Bar status is updated to display the Data tab > Results screen. 
See Chapter 3. Acquiring Sample Data starting on page 13 for more information. 

 

Data Tab: Contains the three sequential screens in the data analysis workflow.  
For example, in the Data tab you must first Select a scan result before you can view 
its count Results. You can also perform a Recount by fine-tuning assay parameter 
settings to be used in the analysis to create a new scan result. As you move through 
screens in this workflow, the Navigation Bar status is updated to display the  
current screen. 

Only the Select screen can be selected as an option if you decide to review other 
count results after viewing the currently selected scan. See Chapter 4. Analyzing 
Scan Results starting on page 23 for more information. 
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 Manage Tab: Contains the various system lists of assays, cell types, ACS templates 
and report templates used in the Data Acquisition and Data Analysis workflows. 

• In the Assays screen you can view the library of assays available in your system, 
import/export assays, manage the list of assays as well as create new/modify 
existing assay details. See Chapter 6. Managing Assays starting on page 41. 

• In the Cell Types screen you can view the library of cell types available in your 
system, import/export cell types, manage the list of cell types as well as create 
new/modify existing cell type details. See Chapter 7. Managing Cell Types 
starting on page 61. 

• In the ACS Templates screen you can view the library of ACS templates available 
in your system, import/export ACS templates and manage the list of ACS 
templates. ACS Templates cannot be created or viewed in the Matrix software. 

 ACS templates can be used for populating data into specified formats when files 
are generated on export. If the Auto Open export option is also selected, the  
De Novo Software FCS Express application (if installed) is launched for viewing 
the output file. See Chapter 8. Managing ACS Templates starting on page 71. 

• In the Report Templates screen you can view the library of report templates 
available in your system, import/export report templates, and manage the list 
of report templates as well as create new/modify existing template details. See 
Chapter 8. Managing Report Templates starting on page 71.  

If the Matrix 21 CFR Part 11 module has been enabled for your system, a user hierarchy must be established 
requiring the creation of roles that control varying levels of access to functionality available in each of these tabs. 
See Chapter 9. Using the 21 CFR Part 11 Module starting on page 85 for details. 
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VIEWING SOFTWARE VERSION 

The Home tab displays the logo for the instrument to which you are connected (e.g., Cellaca MX as shown below).  

For instruments that can be run using multiple versions of the software, the                                                                      
logo distinguishes the Matrix software from previous versions available for the instrument. 

This Home tab also contains the About Matrix button which displays Product Information (e.g., software version, 
instrument serial number/firmware version, and camera serial number), and Contact Us details.   

For details on using the Generate Diagnostic Report and Clear All Logs buttons to assist the Support team with 
troubleshooting technical issues, see Generating Diagnostic Reports on page 104. 

WARNING: Logs may be required to maintain a historical archive. As using the Clear All Logs  
button will permanently remove accumulated logs for the installed Matrix software version, it  
is recommended that you contact IT before clearing logs from your system. 
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Chapter 3. Acquiring Sample Data 

This chapter describes functionality available in the two screens used to acquire sample data − Setup and Preview. 
After loading samples into the instrument you must complete these screens in sequence. For example, you must 
first enter Setup details before advancing on to Preview the sample. 

• Upon entering setup details, selecting at least one well and then clicking the Preview button located at the 
bottom of the Setup screen, the instrument engages its camera for viewing live channel images of the sample. 
If it is necessary to modify setup details while you are in the Preview screen, click the Setup option in the 
Navigation Bar to return to the Setup screen and enter new details. 

• After adjusting instrument focus/fluorescent exposure for each channel, click the Count button at the bottom 
of the Preview screen. The instrument camera acquires sample images as specified by the selected assay which 
are then processed by the Matrix imaging and pattern-recognition software to decluster, identify and count 
individual cells according to defined cell type parameters. 

Once a count has been performed, the Navigation Bar status is updated to display the Data tab > Results screen. 
The scan result created as a result of the count is displayed at the top of the Results List. See Chapter 4. Analyzing 
Scan Results starting on page 23 for details. 

ENTERING SETUP DETAILS 

As the Matrix software is shared by multiple product families, it must account for physical differences between 
instruments such as the format of consumables. To accommodate for these differences, a variation exists in the 
Well Details area of the Setup screen as indicated by the instrument-specific sections below. Although the visual 
presentation of these differences varies, the core functionality driving these tasks remains the same. 

Upon launch of the Matrix software, the Acquire tab > Setup option is displayed by default. Personalize the details 
of your experiment by entering a plate name, selecting an assay to be used, indicating specific plate wells for which 
to capture images (if applicable for your instrument type) and defining how the results data are to be exported. 

Note: After initial setup, an instrument must be calibrated using the Matrix software prior to first use. If you are 
prompted with a message that the instrument has not been calibrated, contact Support by visiting 
https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

Entering Setup Details 

The Setup Details area allows users to enter a customized plate name, select an assay and view/edit its details, 
select a tag and enter a dilution factor. 

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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Users can enter the following information in the Setup Details area. 

Plate Name Customize the default plate name of “New Sample” to identify contents of the plate. If a 
plate name is not entered, a date/time stamp will be appended to the “New Sample” default 
(e.g., New Sample 2023/08/25-10:58:09).  

Select Assay Select an assay from the drop-down and verify the assay description displayed. To view 
and/or edit assay details, click the                 button. Clicking the View button automatically 
updates your progression in the Navigation Bar to the Manage tab > Assays option. Click the 
Back or Save and Back (after making any changes) button to return to the Setup screen. 

Note: If an assay is locked for editing (i.e., the Category field displays                       or Locked 
instead of Unlocked), users must first click Save As to save it as a new assay before they can 
edit parameters. See Editing an Assay on page 45 for details. 

Tag Select a tag from the drop-down or enter a new one. Tags are used to logically group scan 
results together for the purpose of custom reporting (e.g., Time Course Analysis). Tags have a 
maximum length of 32 characters and can be applied to any number of results, but can only 
be applied to one result derived from each scan. See Creating a Time Course Series on page 
37 for details on how tags can be used to create custom reports. 

Dilution Factor Enter the final dilution factor for the sample. 

Entering Well Details (for Cellaca MX/PLX) 

This section describes well selection functionality for instruments using multi-well plates such as Cellaca MX/PLX.  

The Well Details area for the Cellaca MX identifies the Plate Type being used and requires you to select loaded 
wells in the Well Selection plate map. 

To select wells individually, click on each well to select or de-select it accordingly. To select a group of wells, click 
on a well at the beginning of the group and hold the mouse button down while dragging your mouse to the end of 
the group before releasing it. To select or de-select all wells, click the All Wells  icon. 

When well selection is complete, selected wells will be highlighted in orange on the plate map.  
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For Cellaca PLX, you can also specify number of Images Per Well (i.e., 1 or 4) to be captured during the count, as 
shown below. The Images Per Well Indicator for multi-well plates or PLX slide holder (provided with the instrument 
and holds up to four PLX slides containing two sample chambers per slide) depicts the selected number of images 
representing cross-sections of the area in each well. 

NAMING WELLS 

Once well selection is complete, you can expand the Well Names area below the map to see the corresponding 
well name fields also highlighted in blue. These fields allow you to enter well names or import them from a file to 
identify samples loaded into each well. 

To manually enter well names, simply click on each highlighted field individually and enter a name for that well. As 
an alternative, you can use the following buttons to import, save and reset selected well names.  

Import Button Allows users to import a previously saved .csv file containing well names. Click the                 
button, navigate to where .csv file is stored, select the file and click Open to load well names. 

Save Button Allows users to save the currently displayed well names as a file that can be loaded back into 
the system for use with another plate. Click the              button and navigate to where the .csv 
is to be stored. Enter a name for the file and click Save, followed by clicking OK in response to 
the confirmation prompt. Users can open the file in a .csv compatible application (such as MS 
Excel) and rename the wells before importing the file again. 
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Reset Button Allows users to clear the currently displayed well names. Click the                 button followed 
by clicking Yes in response to the confirmation prompt. Well names that have been cleared 
will remain highlighted in blue for your reference. 

After well details have been entered, continue with your sample setup by Setting Auto Export Options on page 17. 

Note: If you are creating a time course series of data for use in custom reporting, it is critical that well names be 
consistent for all scan results in the series. See Creating a Time Course Series on page 37 for details. 

Entering Well Details (for Cellometer K2) 

This section describes images per well functionality for instruments using chambered slides such as Cellometer K2.  

The Well Details area for the Cellometer K2 identifies the Plate Type being used for the sample and allows you to 
select the number of Images Per Well (i.e., 1, 4 or 8) to be captured during the count, as shown below. 

The visualization of Images Per Well for the slide depicts the selected number of images (i.e., cross-sections of the 
area in the counting chamber or “well”) to be captured during the scan. A comparison of Total Volume Measured 
for K2 images in relation to hemocytometer quadrants is provided below.  

Total Volume Measured For K2 Images Per Well:   

 Count from 1 image per well =  0.15 µL  
 Count from 4 images per well =  0.6 µL (or 6 quadrants of a hemocytometer) 
 Count from 8 images per well =  1.2 µL (or 12 quadrants of a hemocytometer) 

Total Volume Measured For Hemocytometer Quadrants: 

Count for 1 quadrant = 0.1 µL Volume Per Quadrant using an average of  
4 quadrants result in 0.4 µL Total Volume Measured 
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Setting Auto Export Location 

Expand the Reports and Exports area to identify a Location for automatic exports of images/data and generated 
output files for reports. Click the Browse button and navigate to a folder on your Operating Computer or network 
to define the default export path. This path will remain as the default in the software until it is manually changed. 

In addition, Exports (e.g., Raw Images, Colorized Images, Well Level CSV, Object Level ACS, Object Level CSV and 
Dataset) and output files for Reports (e.g., CSV, Excel, PDF and Word) defined for the current assay are displayed. 

Note: To modify Report and Export settings displayed, click the View button for the selected assay in Setup Details 
area and expand the Reports and Exports section to update Exports and Reports file types selected. See Managing 
Assay Reports and Exports on page 57 for details. 

PREVIEWING THE SAMPLE 

Once you have completed entering setup details for your sample, click the  button located at the bottom 
of the Setup screen. The instrument engages its camera for viewing the sample and displays the Preview screen. 
Users can view live images of samples in selected wells, preview available channels for Imaging Mode associated 
with the assay, adjust instrument focus and confirm fluorescence exposure for each channel. 

Note: Although the Acquire tab > Preview option appears in the Navigation Bar, you cannot access the Preview 
screen directly as it requires well details entered in the Setup screen. Once you click the Preview button at the 
bottom of the Setup screen, the Navigation Bar is updated to show your progression to the Preview screen.  

Previewing Live Images (for Cellaca MX/PLX)  

This section describes previewing live image display for instruments using multi-well plates such as Cellaca MX/PLX.  

In the Wells area, click on highlighted wells to view live images of samples contained in the counting plate or PLX 
low fluorescence slide. As you move from well to well, the live image changes per selected well (i.e., indicated in 
the plate map by an outline surrounding the well). 

To zoom in/out of an image, move the mouse to hover cursor over 
the viewing pane and turn the scroll wheel or, if using the 
touchscreen (for MX only), apply universal gestures (e.g., touch 
center of image with two fingers and then spread them apart to 
zoom in and reverse this action to zoom out). Current Zoom 
magnification is displayed in bottom right corner of viewing pane.  
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To move a zoomed image around, click and drag the image  
to a new location as needed. 

For Cellaca PLX only, if the Images Per Well option of 4 is  
selected, you can also select a specific quadrant within 
a well by clicking on the indicator below the Well Map. As you 
move from well to well (and from quadrant to quadrant), the  
live image changes per selected well and quadrant. 

Previewing Live Images (for Cellometer K2)  

This section describes previewing live image display for instruments using chambered slides such as Cellometer K2.  

In the Wells area, click on highlighted image sections in  
the slide visualization (i.e., representing cross-sections of the  
counting chamber or “well”). As you move from section to  
section, the live image changes per your selection. 

To zoom in/out of an image, move the mouse to hover cursor  
over the viewing pane and turn the scroll wheel or, if using the 
touchscreen, apply universal gestures (e.g., touch center of image 
with two fingers and then spread them apart to zoom in and reverse 
this action to zoom out.) Current Zoom magnification is displayed in 
bottom right corner of the viewing pane.  

To move a zoomed image around, click and drag the image to a new location as needed. 

Adjusting Focus (for Cellaca MX/PLX)  

This section describes adjusting instrument focus using internal controls via Matrix software for Cellaca MX/PLX. 

To adjust the focus of the live image being previewed, use the Focus controls as indicated below. Obtaining good 
focus is key to ensuring accurate cell counts. 

 

Auto Focus Button Allows the instrument to determine the best focal position for the selected well. 

Focus Position Allows users to enter a numerical value for the vertical (Z) position of the objective lens. 

Fine Focus Manual 
Offset Buttons  

Allows users to finely adjust the vertical (Z) position of the objective lens for 
optimal focus (in µm). Click the up/down arrow to adjust focus accordingly.  

Coarse Focus Manual 
Offset Buttons 

Allows users to coarsely adjust the vertical (Z) position of the objective lens for 
optimal focus (in µm). Click the up/down double-arrow to adjust focus accordingly.  

Once focus has been properly adjusted, continue by Previewing Channel Images, below. 
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Adjusting Focus (for Cellometer K2)  

This section describes adjusting instrument focus using external Focus Knob available on Cellometer K2.  

To adjust the focus of the live image being previewed, slowly turn the Focus Knob located on the right side of the 
instrument until cells/beads are in focus.  

Obtaining good focus is key to ensuring accurate cell counts. Once good focus  
has been achieved, the instrument should perform most counting operations  
with only minor adjustments. 

Previewing Channel Images 

In the Preview area, channels available for viewing (e.g., Channel 1, Channel 2, etc.) are displayed based on the 
instrument and assay Imaging Mode. The Channel 1|BR1 image is displayed by default. Clicking the FL button 
displays the Channel 1/FL1 image.  

If only one channel is available, the Preview field channel drop-down  
will be hidden. In addition, if the BR Only Imaging Mode is selected, the  
FL button will also be hidden.  

If multiple channels are available (e.g., Channels 1-6 for Cellaca MX/PLX  
or Channels 1-2 for Cellometer K2), use the Preview field channel drop- 
down to switch between channels. For example, sample Channel 1|FL  
and Channel 2|FL images are shown below.  

 

Notes:  

• For BR/FL imaging modes, each channel will be associated with two images − Brightfield (BR) and Fluorescent 
(FL). These images are referred to in assay channel mappings as BR1/FL1, BR2/FL2, etc.  

• When working with assays that have more than one channel, use the Channel 1/BR image to adjust focus and 
then select the FL image to confirm exposure. For Channels 2-6, you only need to select the FL images to 
confirm exposure since focus of their paired BR images is adjusted automatically when you performed the task 
for Channel 1. For K2 instruments, a slight offset may exist between BR1 and BR2 images due to the distance 
the camera must travel. 
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When previewing fluorescent images, confirm that FL signal is strong but has a low, dark background. Modify the 
FL Exposure default to increase (prolong) or decrease (shorten) the exposure time accordingly.  

PERFORMING A COUNT 

Once you have completed previewing the live image for the sample, click the  button located at the 
bottom of the Preview screen. The instrument camera acquires sample images as specified by the selected assay 
which are then used by the Matrix software to calculate count results according to defined cell type parameters. 

Note: Depending on the number of selected wells/images per well and defined assay parameters, the counting 
process can take a few seconds to up to a few minutes. 

At the start of count processing, the Navigation Bar status is updated to display the Data tab > Results option. 

As the system acquires sample images and calculates count results,  
the colors used to mark selected wells/images per well will change to 
indicate status (i.e., from Selected to Acquired to Counted) as shown in 
the legend appearing below the Well Map.  

As soon as a well is Counted, you can click on it to display count results 
below the viewing pane. Count results will be displayed, printed and 
exported based on templates defined for the assay. 

Well images displayed can be varied by toggling on/off available channel 
buttons (displayed across the top of the viewing area of the Well View 
tab) and enhancing the Zoom magnification.  

To zoom in and out of sample images, move the mouse to hover the cursor over the viewing pane and turn the 
scroll wheel or, if using the touchscreen, apply universal gestures (e.g., touch the center of the image with two 
fingers and then slowly spread them apart to zoom in and reverse this action to zoom out). Current magnification 
is displayed in bottom right corner of viewing pane.  

When counting of all wells is complete the scan result will be added to the top of the Results List displayed on the 
Select screen. In addition, Reports and Exports output files defined for the current assay are automatically stored in 
the specified location. See Chapter 4. Analyzing Scan Results starting on page 23 for details. 
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Results Display for Cellaca MX/PLX 

When viewing count results for plate-based instruments such as Cellaca MX, a single image is displayed 
representing the sample in the outlined well. Click on other highlighted wells to view their sample images. 

For Cellaca PLX only, if Images Per Well of 1 is selected, a single image is displayed per well (as with the MX). 
However, if Images Per Well of 4 was selected, a composite image is displayed containing four separate images 
representing each quadrant of the well. 

Using a PLX slide holder produces the same results – if Images Per Well of 1 is selected, a single image is displayed 
per well. However, if Images Per Well of 4 is selected, a composite image is displayed containing four images. 

To move an image around, click once inside the viewing pane and drag the image to a new location as needed. 
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Results Display for Cellometer K2 

When viewing count results for slide-based instruments such as Cellometer K2, the number of images displayed 
will vary based on your Images Per Well selection. Multiple images are stacked in a single viewing pane. 

To move an image around, click once inside the viewing pane and drag the image to a new location as needed.  
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Chapter 4. Analyzing Scan Results 

This chapter describes functionality available in the three screens used to analyze scan result data − Select, Results 
and Recount. When analyzing scan results you must complete these screens in sequence. For example, you must 
first Select a scan result before you can view its count Results. You can then perform a Recount by fine-tuning assay 
parameter settings to be used in the analysis to create a new scan result.  

• To open a scan result contained in the Results List of the Select screen you can either double-click the result, 
or click it once (to highlight it in the list) and then click the View button. See Selecting Scan Results, below. 

• Once a scan result is displayed in the Results screen you can analyze it by selecting/de-selecting channels to 
vary the image and click on highlighted wells to review the data. If you find it necessary to choose another scan 
result, click the Select option in the Navigation Bar. See Viewing a Scan Result on page 24 for details. 

• To perform a Recount you can select either a new assay or click the View button for the current assay to edit 
its parameter settings, and then click the Recount button. See Performing a Recount on page 30 for details. 

As you move through screens in this workflow, the Navigation Bar status is updated to display the current screen. 
After a recount is performed, the Navigation Bar returns to the Data tab > Results screen. 

SELECTING SCAN RESULTS 

The Select screen displays all Scan Results currently generated or loaded into the database for your system. From 
this screen you can search for, select and view scan results. In addition, scan results can be imported/exported, 
deleted or renamed. If scan results are deleted, users can recover free space available in the database. 

Use the Per Page control drop-down                                     (contains values from 5 to 500) located in the upper right 
corner of this screen to select the number of scan results to be displayed per page, and the                          arrows to 
move back and forth between list pages. 

See Managing the Results List on page 25 for more information on managing scan results contained in this list. 
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Searching for a Scan Result 

To search for a scan result you can either enter a few key characters from a plate name into the Search field and/ 
or expand the Filters area by clicking the down arrow               to specify search criteria.  

Refine your search by selecting a plate type or assay name, clicking on an imaging mode or product type, selecting 
a tag, indicating whether to include scans without results, or entering a range of dates between which a scan and/ 
or result was created. As you enter search criteria, the Results List is updated with matching entries.  

If you find it necessary to clear all selected filters and begin the search again, click the Reset button. 

Note: The Matrix software is designed to support multiple product types (e.g., Cellaca MX/PLX and Cellometer K2) 
and displays all available scan results in the Results List regardless of whether the Operating Computer is physically 
connected to that instrument. 

Viewing a Scan Result 

To open a scan result contained in the Results List you can either double-click the result or click it once to highlight 
it in the list and then click the View button. The Results screen is displayed.  

Note: As all available scan results are contained in the Results List, you may be able to view scan results taken by 
an instrument that is different from the one to which your system is currently connected. 
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MANAGING THE RESULTS LIST 

The following functionality is available when viewing the Results List. 

Import Button Allows user to import previously stored scan results (stored as .SCANRESULT files) from an 
external location. 

Export Button Allows users to export selected scan results (to be stored as .SCANRESULT files) to an 
external location. 

Delete Button Allows users to delete the selected scan result. If the Matrix 21 CFR Part 11 module is 
enabled, users will be prompted to enter a reason prior to deletion. 

After data has been deleted, click the Recover Free Space button (if displayed) to recover 
space that the data previously occupied in the database. 

Rename Button Allows users to rename the selected scan result. New plate name entered must be unique. 

Tags Allows users to select a tag from the drop-down or enter a new one to apply it to the 
currently selected scan result. Tags can be used to create custom reports. 

Recover Free 
Space Button 

Allows users to recover free space that continues to be occupied in the database even after 
scan result data previously stored in that space has been deleted.  

Note: When scan results are deleted, the database does not immediately return space 
previously used by deleted data to the operating system. Instead, this process occurs 
gradually over time. The Recover Free Space button allows users to return unoccupied 
database space to the operating system at the time the operation is performed.  

Users must have System Admin rights for the database for this button to be displayed. In 
addition, as this process requires high CPU utilization during operation it is recommended 
that you not click perform other functions until this operation is complete. 

View Button Allows users to open the selected scan result for viewing. 

 

VIEWING COUNT RESULTS 

Once you have opened a scan result for viewing, you can view count results presented in the Results screen. 

Understanding Default Report Tabs 

Report tabs initially displayed across the top of the viewing pane are associated with report templates that have 
been assigned to the current assay and are enabled by default to format the presentation of scan result data.  
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Although the Well View tab will always be enabled for display, you can change the report template assigned to this 
tab. In addition, you can disable any other default report tabs (e.g., Summary and .csv tabs for Matrix v4.0+;  
All Wells tab for Matrix v3.0), change the report templates used for display of these tabs, and/or add new tabs. 
See Chapter 5. Customizing Scan Result Reports on page 33 for details.  

Note: As of the Matrix v4.0 release, users can customize report tabs displayed when viewing count results. Tabs 
enabled for display by default have been changed as noted below: 

• The Well View report tab available in earlier releases will always be enabled. However, users can change the 
Display report template assigned to this tab or edit the template directly. Any changes made to a report 
template in use by other assays will also be applied to other scan results the next time a recount is performed. 

• The All Wells tab available in earlier releases has been replaced with the Summary tab. In addition, a new .csv 
tab may be enabled. Users can change report templates assigned to these tabs, edit the templates directly 
(i.e., any changes made will also be applied to other scan results using these templates), disable them from 
displaying as tabs or delete them from the assay. 

• Tabs enabled for display by default are identified by version numbers included in an assay name (e.g., 
MX405.0_AOPI_Cell Lines will include default tabs enabled in the Matrix v4.0 release).  

CHANGING WELL VIEW IMAGE DISPLAY 

The Well View tab will always be displayed in the Results screen and includes both an image and the associated 
count results for the selected well. To change the well view image displayed, use one of the following methods 
based on your instrument: 

• When viewing count results for plate-based (Cellaca MX/PLX ) or slide holder-based (Cellaca PLX) instruments, 
a single image represents the sample in the outlined well. To display images for other acquired samples, select 
their highlighted well in the Well Map. For Cellaca PLX, if the Images Per Well option of 4 is selected, a single 
well image may be a composite of four separate images representing each quadrant of the well. To move the 
image around, click and drag the image to a new location as needed. 

• When viewing count results for slide-based instruments such as Cellometer K2, the number of images displayed 
for the outlined well varies based on your Images Per Well selection. Multiple images taken are stacked into a 
single composite image. To move the image around, click and drag the image to a new location as needed. 

You can zoom in/out of the well view image by clicking once in the 
viewing pane and turning the mouse scroll ball or, if using a 
touchscreen, by applying universal gestures (e.g., touching center  
of image with two fingers and then spreading them apart to zoom  
in and reverse this action to zoom out). 

Zoom magnification is indicated in bottom right corner of the viewing 
pane and can be increased up to 10.00x. 

At the bottom of the Well View tab is a report containing well-level 
data for the sample in the selected well.  
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VARYING WELL VIEW CHANNELS/COUNTED OVERLAY DISPLAY 

In the Well View report tab displayed by default, the following buttons may be available across the top of the 
viewing pane based on the Imaging Mode defined in the current assay.  

• Click the Brightfield (BR) or Fluorescence (e.g., FL1, FL2, FL3,  
etc.) buttons to select/de-select channels used in the image 
display. Channel views are overlaid on top of each other. 

• Click the  button to show/hide a graphic overlay that 
identifies Counted cells by surrounding them with color- 
coded outlines. For 2-channel Viability assays, Green is used  
for counted/live cells, Red for dead cells and Yellow for cells  
not counted (e.g., if larger than the specified cell diameter).  
For Expression assays, Blue is used for outlining total cells in  
the masked channel.  

• Click the  button to enable/disable display of the  
current Zoom magnification in bottom right corner of viewing 
pane. Zoom feature will still be functional even if not displayed. 

Understanding Custom Reporting 

The Matrix custom reporting feature allows you to assign and/or modify report templates to be used by assays 
when generating scan results. You can change the report template used for display of the Well View report (which 
is always displayed) and add report templates to be enabled as tabs or output as specific file types (e.g., CSV, Excel, 
PDF and Word) that can be opened/printed upon report generation.  

Note: Any changes made to Reporting options for an assay will be saved with the assay and applied to all other 
scan results using that assay the next time a new scan or recount is performed. 

For example, a custom Growth Curve report tab has been enabled in the scan result shown below. Clicking this tab 
displays data in the format defined by the associated report template (i.e., illustrating calculation of a growth curve 
for a time course series of scan results).  

See Chapter 5. Customizing Scan Result Reports on page 33 for details on customizing Reporting options.  
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Verifying Auto Exports 

Expand the Exports area in the Results screen to verify that automatic 
exports were completed and click the location link to open folder where 
the exported scan result files are stored. 

In addition, if you defined any output file types (e.g., CSV, Excel, PDF and 
Word) to be generated for assay report templates, you can verify that 
selected file type exports were also completed. 

Exporting and Printing Scan Results (Manual Settings) 

To manually select additional export options (images/data) for scan result files as well as generated output files for 
reports, click the Export button located at the bottom of the Results screen. The Export dialog is displayed. 

Confirm the export Location and if necessary update this path by clicking the Browse button, navigating to a folder 
on your Operating Computer or network, and clicking OK. 

Select scan result Images (e.g., Raw Images or Colorized Images), Data (e.g., Well Level CSV, Object Level CSV and 
Object Level ACS) and Archive (e.g., Data Set) file options to be exported to the specified location. Data Sets are 
stored as .SCANRESULT files. 

In addition, for reports associated with the scan result you can select generated output file types (e.g., CSV, Excel, 
PDF and Word) to be exported and indicate if files are to be opened automatically and/or printed upon export. 

Note: If the Object Level ACS option is selected, the screen expands to display if an ACS template has been 
assigned to the assay and offers an Auto Open option after the report is generated. If no ACS template is displayed, 
users can still export object level ACS data assuming they have the export privilege. To change the ACS template 
assigned to an assay, users will need to edit the assay.  
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For report templates associated with the scan result you can select generated output file types (e.g., CSV, Excel, 
PDF and Word) to be exported and indicate if files are to be opened automatically and/or printed upon export. 

Note: Any changes to export options are applied only when manually exporting scan results (i.e., by clicking the 
Export and Print button) and will not be saved with the assay or scan result. 

Renaming Wells 

You can rename wells as necessary for a scan by clicking the Rename Wells button located at the bottom of the 
Results screen. Wells that were selected for the scan are highlighted in blue and contain the current well names. 
All remaining wells will be blank and disabled for editing. 

Note: As well names are associated with a scan and not individual results derived from that scan, renaming wells in 
a scan result will affect well names used for ALL results (counted or recounted) generated from that scan.  

To manually enter well names, simply click on each highlighted field individually and enter a name for that well. 

As an alternative, you can use the following buttons to import, save and reset selected well names.  

Import Button Allows users to import a previously saved .csv file containing well names. Click the                 
button, navigate to where .csv file is stored, select the file and click Open to load well names. 

Note: Using this button when editing a scan result imports only those well names that were 
selected/enabled for the scan. All other well names in the imported file will be ignored. 

Save Button Allows users to save the currently displayed well names as a file that can be loaded back into 
the system for use with another plate. Click the              button and navigate to where the .csv 
is to be stored. Enter a name for the file and click Save, followed by clicking OK in response to 
the confirmation prompt. Users can open the file in a .csv compatible application (such as MS 
Excel) and rename the wells before importing the file again. 

Reset Button Allows users to clear the currently displayed well names. Click the                 button followed 
by clicking Yes in response to the confirmation prompt. Well names that have been cleared 
will remain highlighted in blue for your reference. 

After any changes to well names have been saved, reports enabled as tabs in the Results screen will immediately 
be updated to display the new well names. 

Note: If you are creating a time course series of data for use in custom reporting, it is critical that well names be 
consistent for all scan results in the series. See Creating a Time Course Series on page 37 for details. 
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PERFORMING A RECOUNT 

If you find it necessary to fine-tune assay parameters after reviewing your data results, click the Recount button 
located at the bottom of the Results screen. The Recount screen is displayed.  

Once you have made any necessary changes (per the options described below), click the Recount button located at 
the bottom of the screen. After a recount is performed, the Navigation Bar returns to the Results screen. 

Refining Assay Details/Selecting New Assay 

In the Recount Details area you can view parameter settings for the Last Used assay, select a new assay from the 
drop-down or view the current assay to edit parameter settings to be used in the recount. See Editing an Assay on 
page 45 for details. 

De-selecting Wells 

In the Well Selection area you can de-select wells previously highlighted to exclude them from the recount (e.g., to 
increase counting speed). You cannot add wells to the recount that were not selected for the initial count.  
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Managing Channel Mappings 

Expand the Channel Mappings area to identify Scan Channels and Recount Channels for the Imaging Mode associated 
with the current assay. Performing a recount uses channel mappings as defined by default (i.e., Recount Channels will 
remain in same positions used for the original Scan Channels).  

Note: With the exception of Brightfield Only configurations (i.e., BR1, BR2, etc.), each channel will have separate 
brightfield and fluorescent images as depicted in the mapping indicators (i.e., BR1/FL1, BR2/FL2, etc.).  

To manage channel mappings for use in a recount, click on individual mapping indicators and drag them to a new 
channel. The mapping indicator in that channel will swap positions with the one you are dragging automatically.  

To return channel mappings to the positions they were in when you first expanded the 
Channel Mappings area, click the Reset button followed by Yes to confirm the action.  

If a new assay selected for recount has fewer channels or you edit the assay previously used to reduce the number 
of channels, mappings displayed are updated to reflect available channels. To manage channel mappings for use in 
the recount, click on mapping indicators and drag them to an available position in the Recount Channels area.  

If dragging an indicator from the Scan Channels to Recount Channels area and the Recount Channels postion is 
already populated, the indicator in Recount Channels will be returned to its home Scan Channels location.  

If you drag indicators from Recount Channels to their home Scan Channels locations, a red outline is used to 
highlight empty Recount Channels locations. All Recount Channels must contain an indicator prior to recount.   



  Chapter 4. Analyzing Scan Results 

8003394 Matrix Software User Manual Rev E  32 

Modifying Auto Export Options 

Expand the Reports and Exports area to identify a Location for automatic exports of images/data and generated 
output files for reports. Click the Browse button and navigate to a folder on your Operating Computer or network 
to define the default export path. This path will remain as the default in the software until it is manually changed. 

In addition, Exports (e.g., Raw Images, Colorized Images, Well Level CSV, Object Level ACS, Object Level CSV and 
Dataset) and output file types for Reports (e.g., CSV, Excel, PDF and Word) defined for the assay will be indicated 
with a blue checkmark. 

Note: To modify Report and Export settings displayed, click the View button for the selected assay in Setup Details 
area and expand the Reports and Exports section to update Exports and Reports file types selected. See Managing 
Assay Reports and Exports on page 57 for details. 

Clicking the Recount Button 

Once you have completed entering recount details for the samples, click the                        button located at the 
bottom of the Recount screen. The Matrix software performs a recount of the scan using the modified parameters 
and displays the new scan result. 
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Chapter 5. Customizing Scan Result Reports 

The Matrix custom reporting feature allows you to assign and/or modify report templates to be used by assays 
when generating scan results in the following ways: 

• The display template used for the Well View report tab may be changed. This tab will always be displayed. 

• Report templates can be enabled/disabled as tabs and arranged to appear in sequence as desired. 

• Report templates can be used to output specific file types (e.g., CSV, Excel, PDF and Word) and open/print 
upon report generation. 

Note: Any changes made to Reporting options for an assay will be saved with the assay and applied to all other 
scan results using that assay the next time a new scan or recount is performed. 

VIEWING CUSTOM REPORTS 

Although the Well View tab will always be enabled for display, you can change the report template assigned to this 
tab. In addition, you can disable any other default report tabs (e.g., Summary and .csv tabs for Matrix v4.0+;  
All Wells tab for v3.0), change the report templates used for display of these tabs, add new tabs and/or view a 
report template to edit its format directly. 

For example, clicking the Summary tab for a scan result displays a full page view containing report data for all 
selected wells. The Summary tab is enabled for Matrix v4.0+ assays by default and the assigned report template 
contains information similar to what was displayed in the All Wells tab available in earlier releases.  

You can either change the report template used for display of this tab or view it to modify the overall format of how 
report objects and data selections are presented.  

Note: Any changes made to report templates will be saved with the assay and applied to all other scan results 
using that assay the next time a new scan or recount is performed. 
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As another example, a custom Growth Curve tab has been enabled for display in the scan result shown below. 
Clicking this tab displays consolidated sample data and line graphs for each group of wells illustrating the 
calculation of a growth curve for a time course series of scan results. This report was generated on a Cellaca MX.  

Note: The Growth Curve shown above was created by assigning the MX5_Growth Curve report template (included 
as a custom report in the Matrix Report Templates Library) to an assay that was run repeatedly on the same 
sample in a time course series with a single tag applied to multiple scan results. See Creating a Time Course Series 
on page 37 for details on how create this custom report. 

SETTING REPORTS AND EXPORTS FOR AN ASSAY 

You can manage Reports and Exports options for an assay in the following areas of the Matrix software: 

• When entering Setup Details in preparation for a count (i.e., Acquire tab > Setup option), select an assay and 

click the  button to edit assay details. 

• When entering Recount Details for a selected scan result in preparation for a recount (i.e., Data tab > Recount 

option), select an assay to be used for the recount and click the  button to edit assay details. 

• When managing details for a selected assay (Manage tab > Assays option) in the Assays List. Double-click on 

an assay in the list or highlight it once and then click the  button to edit assay details. 

Once you are viewing details for an assay, expand the Reports and Exports area by clicking the 
down arrow to view available options. When editing of the assay is complete, click Save and Back to save your 
changes to the assay or Save As to save a copy of the assay that includes your changes with a new name. 

Note: As of the Matrix v4.0 release, report templates are no longer limited to the Display, Export or Print template 
types used in earlier releases. A report template can be created for all these purposes and multiple templates 
assigned to an assay as needed. In addition, report tabs enabled by default will vary based on the Matrix software 
version associated with an assay (e.g., Well View, Summary and .csv tabs are displayed for v4.0+ assays; Well View 
and All Wells tabs for v3.0 assays). Users can change report templates assigned to these tabs, edit the templates 
directly (i.e., any changes made will also be applied to other scan results using these templates), disable them from 
displaying as tabs or delete them from the assay. 
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Changing Template used in Well View Report Display 

The Well View tab is enabled by default for all assays and cannot be disabled. However, you can change the report 
template used for the display of this tab or view the assigned report template and edit its format as necessary. 

To change the report template currently assigned for the 
display of this tab, select a new template from the Display 
drop-down. Click View to confirm the selected template 
suits display needs for the report and edit it if necessary. 

Editing Assay Exports 

Current assay Exports for scan result Images (e.g., 
Raw Images or Colorized Images), Data (e.g., Well Level 
CSV, Object Level CSV and Object Level ACS) and Archive 
(e.g., Data Set) file options to be exported can be edited 
as necessary. Data Sets are stored as .SCANRESULT files. 

If Object Level ACS is selected, the screen is expanded to 
display if an ACS template has been assigned and offers  
an Auto Open option. If no template is displayed, users  
can still export object level ACS data assuming they have 
the export privilege. To change the ACS template assigned 
to the assay, select a new one from the drop-down.  

Managing the Assay Reports List 

The Reports List for an assay may initially contain two report templates enabled by default used in the display of 
the Summary and .csv tabs. Note that the .csv tab may not be available for assays using Expression imaging mode.  

To select a report template and edit how it is being applied to this assay, you can either double-click it in this list or 
click on the report once to highlight it and then click the View button. 

You can use Report Tab Options to disable/enable the display of report templates as tabs and edit/enter tab names. 
A total of five (5) custom tabs may be enabled for display at any one time. In addition, you can select Output File 
Options for report templates and indicate if files are to be opened automatically or printed upon report generation.  
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When you have finished defining options for a report, click the Update Report button to save your changes and 
view the updated Reports List. Repeat this process for each report template to be modified. 

To delete a report template from the Reports List for an assay, click on the report once to highlight it and then click 
the Delete button. You can also add a new report template by clicking the Create button. See Adding Report 
Templates, below for details. 

Note: If the report template deleted was from the Report Template Library provided with the Matrix software, it 
can be re-imported if necessary. If the report template was from a custom library or created using the Matrix 
software, it may be permanently deleted unless it was exported to an external location and saved prior to deletion.  

As report tabs enabled for display are presented in the order in which they appear in the Reports List, you can 
change the sequence of tabs by highlighting a report and clicking the Move Up or Move Down buttons.  

Adding Report Templates 

To add a new report template, click the Create button. Select a template in the Report Template field, choose if 
the report should be enabled as a tab for display (i.e., Yes) and enter a tab name.  

Select any output file types for the report and indicate if they are to be opened automatically (Auto Open) or 
printed upon report generation whenever the assay is used to perform a count/recount. Output of files is 
independent of whether a template is also enabled as a tab. Click Add Report to add the report to the Reports List.  
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CREATING A TIME COURSE SERIES 

Creating a time course series of scan count results is useful when the intent of an experiment is to analyze the 
evolution of cell samples over time. The Matrix software custom reporting feature uses tags to logically group scan 
results in the order they are generated to identify them as part of a sequence. Tags can later be modified when 
viewing scan results in the Results List. 

In this example, a time series of count results was acquired over the course of four days. For the first scan, a plate 
name of Day 1 was entered for cell samples, an appropriate assay (e.g., MX505.0_AOPI_Cell Lines) was selected 
and the tag Growth added. Once a tag is added you will be able to select it from the Tag drop-down in future scans. 

The View button for the assay was selected to present assay details and the Reporting area expanded to create a 
Growth Curve tab (i.e., by assigning the MX5_Growth Curve report template) enabled for display. 

As the experiment progressed and subsequent counts were performed at determined intervals, new plate names 
were entered to reflect the stage of the experiment (e.g., Day 2, Day 3, Day 4) with users continuing to select the 
same tag (e.g., Growth) from the drop-down. 

When the fourth day of the experiment was complete, scan results appeared in the Results List as shown below.  
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Once a scan result is available in the Results List, users can  
highlight it and click the Tags button to change the tag (i.e.,  
add a new tag, edit/replace an existing tag or remove the tag by 
clearing the field). Scan results associated with the same tag will  
be used collectively to create a time series.  

If users find it necessary to refine assay parameters and  
perform a recount for a scan result associated with a tag, they  
will be presented with a notification prompt that the tag is already 
in use by a result of the scan. Users can choose to move the tag to 
the new scan result (Yes), create the new scan result without the  
tag (No), or cancel the recount to select a new tag. 

Note: Although a single tag may be applied to multiple scan results, only one result derived from each scan may be  
associated with the tag. 

Another key concept when creating a time course series is that well names used in scan results must be consistent 
throughout the entire series and if multiple wells on the same plate use the same name, data from those wells will 
be averaged together before generation of the report. Wells can be renamed while viewing a scan result. 

To create a Growth Curve report for this example containing all four scan results, users must select the scan result 
representing the end of the time series to include all data points (i.e., if users viewed the Growth Curve report 
generated for the scan result with plate names Day 1, Day 2 or Day 3 as shown in the series as below, only the data 
points available at each specific point in time for the series will be included in the line chart).  

Details for creating a simple custom time course report template using the DevExpress Report Designer for WPF 
plugin are provided in Creating a Time Course Report Template on page 40.  

For assistance with creating or editing more complex time course time course reporting templates, contact 
Support by visiting https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com  

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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Best Practices and Workflow Tips 

• Time course data is accumulated based on the well names used in scan results. If wells are not consistently 
named throughout the entire series, well data presented in the report may exceed the number of wells on the 
plate and/or include gaps. In addition, if the same well name applies to multiple wells on a plate, data in those 
wells will be averaged together before generation of the report. Wells can easily be renamed after a scan and 
a recount performed to update the scan result. 

• When performing a recount on a scan result currently tagged to be part of a time course series, you will be 
prompted with a Tag Already in Use notification pop-up since the updated result will be derived from the 
same initial scan. Click Yes to move the tag to the updated result. 

• Tags may consist of up to 32 characters in length and are displayed in a column in the Results List. Click on the 
Tag column header to sort scan results in the list by tags. In addition, tags may be used to filter the Results List 
to limit the display of scan results. 

• If a tag is associated with a time course series, selecting the scan result with the most recent Scan Creation 
timestamp will include all data available for the report. Selecting a scan result in the middle of the series will 
display only data available at that specific point in time. 

• To add a tag to be associated with multiple scan results, highlight all results before clicking the Tags button. 
Click once to highlight the first result and then hold either the Shift key (to select a block of results) or Ctrl key 
(to select non-contiguous results) down while clicking additional results. Any changes you make to the tag will 
be applied to all selected scan results. 

• To change a tag associated with multiple scan results that are assigned the same tag, highlight all results 
before clicking the Tags button. Click once to highlight the first result and then hold either the Shift key (to 
select a block of results) or Ctrl key (to select non-contiguous results) down while clicking additional results. 
Any changes you make to the tag will be applied to all selected scan results.  

• To delete tags associated with one or more scan results, highlight all results containing the tags to be deleted 
before clicking the Tags button. Click once to highlight the first result and then hold either the Shift key (to 
select a block of results) or Ctrl key (to select non-contiguous results) down while clicking additional results. 
Ensure the New Tag field is blank and click Change Tags to remove the tags from all selected scan results.  
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CREATING A TIME COURSE REPORT TEMPLATE 

Users can create a time course report template to illustrate data collected from a time course series by selecting 
the Manage tab > Report Templates option and clicking the Create button located at bottom of the screen. See 
Editing a Report Template on page 80 for details on using the Report Template Designer. 

Follow these steps to create a simple time course report template containing a chart: 

1. From the Control Toolbox displayed along the left side of viewing pane, select the Chart  object and drag it 
onto the template. The Chart Designer window opens automatically. 

2. Click the Change Chart Type  icon located above the navigation panel on the left. Use the scroll bar to 
select the desired chart type (e.g., Line in the Line Series section). 

3. In the navigation panel, click “Series 1” once to highlight it. 

4. In the panel displayed on the right, click the Data tab. From the objectDataSource1 list displayed, expand the 
TimeCourseData list (must be expanded for both levels). 

5. Select and drag ScanCreationTimeStamp into the Argument cell below the list. 

6. Select and drag LiveCount into the Value cell below the list. 

7. Click OK followed by the Select Result button (located at bottom of the screen). 

8. Choose a result that has a value in the Tag column and click Select. If a tag is associated with multiple results, 
selecting the result with the most recent Scan Creation timestamp will include all the results in the chart while 
selecting a scan result in the middle of the series will display only data available at that point in time. 

9. Click the Preview tab (located in upper right corner of screen) to preview the chart with selected data. 

10. Click Save and Back to enter a name for the time course report template. 

Once you’ve created a time course report template, assign it to an assay being used for the collection of time 
series data and enable it for display as a report tab (e.g., Growth Curve). Ensure that tags have been added to scan 
results identifying key data points in the time course series and select a scan result associated with that tag to be 
used as the endpoint for the report. 

To create a more complex time course report template or for assistance using Report Template Designer, contact 
Support by visiting https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

   

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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Chapter 6. Managing Assays 

This chapter describes how assays are displayed in the Assays List and how to manage the list to keep it current.  
Details on how to edit and create assays are also provided. Assay parameters can be optimized before each count 
/recount to meet your analysis needs. 

Note: When migrating to the Matrix database from an earlier version, updated assays can be imported via the 
software after migration is complete. For a list of assays provided with the Matrix software or for assistance in 
defining a custom assay, contact Support by visiting https://www.revvity.com/contact-us or send email to:  
CellC-support@revvity.com 

VIEWING THE ASSAYS LIST 

You can manage assays available for your instrument system by clicking the Manage tab > Assays option to view 
the Assays List. From this screen you can import/export, rename and delete assays appearing in the Assays List, as 
well as show/hide assays displayed in the Assays drop-down appearing in other screens. 

In addition, you can select an assay from the list to view/edit its details, create a new assay by defining custom 
parameter settings or use a locked assay as a source for creating a new assay based on its parameter settings. 

Note: If the Matrix 21 CFR Part 11 module is enabled, the Create button (and Save and Back button when viewing 
assay details) will only be available for users who have been granted permission to perform these functions. 

Use the Per Page  control to change the number of assays displayed per page and the                       
arrows to move back and forth between pages in the list. 

Assays can be sorted by clicking on column headings (i.e., ascending         /descending         indicators will be 
displayed) and information presented for each assay includes name, description, the product for which it is 
intended, imaging mode defined for the assay and created/last modified dates.  

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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Icons displayed in the State column indicate whether an assay was provided as a Revvity System  standard, 
(which cannot be edited) or if an assay is currently Locked       or Unlocked        . When viewing System and Locked 
assays, a Save As button allows users to copy defined parameter settings as a source for creating a new assay. 

A checkmark      displayed in the Shown column indicates the assay is to be included in the Assays drop-down 
available in other screens (e.g., Select Assay field in the Acquire tab > Setup screen and Assay for Recount field in 
the Acquire tab > Recount screen).  

SEARCHING FOR ASSAYS 

To search for an assay, enter a few key characters of an assay name or description in the Search field and/or 
expand the Filters area by clicking the down arrow               to specify search criteria.  

As you choose filters (e.g., by selecting Imaging Mode, Category, Shown and Product options) or enter a Created 
Between/Modified Between range of dates, the Assays List is updated automatically to display matching entries.  

Imaging Mode Choose from the following imaging modes: 

BR − Filters for assays with Brightfield 
BR/FL − Filters for assays with Brightfield and Fluorescence  

Channels Use the drop-down to select one or more channels to 
be included in the search, then click OK.  

 

Category Choose from the following categories: 

Unlocked − Filters for assays that are unlocked and can be edited 
Locked − Filters for assays that are locked and cannot be edited 
System − Filters for assays provided by Revvity (locked and cannot be edited) 

System assays are no longer available in the Assay Library provided with the Matrix 
software but may exist on your system if imported from an earlier release. 

Shown Choose from the following Shown states: 

Shown − Filters for assays selected to appear in the Assays drop-down 
Hidden − Filters for assays that do not appear in the Assays drop-down  

Note: The Assays drop-down is available in other screens (e.g., Select Assays field in 
the Setup screen and Assay for Recount field in the Recount screen). 
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Product  Choose from the following products: 

MX − Filters for assays selected to be used for the Cellaca MX 
PLX − Filters for assays selected to be used for the Cellaca PLX 
K2 − Filters for assays selected to be used for the Cellometer K2  

Created Between Enter a Created Between range by selecting start/end dates representing a time period 
during which to filter for assays that were created. 

Modified Between Enter a Modified Between range by selecting start/end dates representing a time 
period during which to filter for assays that were modified. 

If you find it necessary to clear all selected filters and begin the search again, click the Reset button. 

To select an assay and view its details, double-click it in the Assays List or click the assay once to highlight it and 
then click the View button located at the bottom of the screen. 

MAINTAINING THE ASSAYS LIST 

When you select an assay, buttons at the top of the Assays List become available to perform the following 
functions. The Import button will always be available as it does not require the selection of an assay in your library. 

Note: If the Matrix 21 CFR Part 11 module is enabled, buttons will only be available for users who have been 
granted permission to perform specific functions. 

Importing Assays 

1. While viewing the Assays List, click the Import button.  

2. Navigate to a folder where an external assay library is 
available or an assay was previously saved.  

3. Select one or more .ASSAY files to be imported. Keep  
in mind that cell types and report templates associated  
with selected assays will also be included in the import. 

4. Click Open. If selected assays (or cell types and report 
templates associated with the assays) already exist in your 
database, respond to confirmation prompts by overwriting 
the files in your system, auto renaming the files on import  
or canceling import of the file. 

5. Click OK to acknowledge the successful import and confirm  
that imported assays are displayed in the Assays List.  
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Exporting Assays 

1. Select one or more assays from the Assays List to be 
exported by clicking once to highlight the first one and 
then holding either the Shift key (to select a block of 
assays) or Ctrl key (to select non-contiguous assays)  
down while clicking additional assays. 

2. Click the Export button. 

3. Navigate to a folder where assays are to be saved.  

4. Click OK to save .ASSAY files in the export location.  

Renaming Assays 

The Rename button will only be enabled for unlocked assays.  

1. Select the assay to be renamed and click the Rename button.  

2. Edit the assay name and click Rename to save your changes. 

Deleting Assays   

1. Select one or more assays from the Assays List to be 
deleted by clicking once to highlight the first one and 
then holding either the Shift key (to select a block of  
assays) or Ctrl key (to select non-contiguous assays)  
down while clicking on additional assays.  

2. Click the Delete button followed by Yes to confirm the action.  
If the Matrix 21 CFR Part 11 module is enabled, users will be 
prompted to enter a reason prior to deletion. 

Note: If assays deleted were from the Assay Library provided with the Matrix software, they can be  
re-imported if necessary. If assays were from a custom library or created using the Matrix software, they may 
be permanently deleted unless assays were exported to an external location and saved prior to deletion. 

Showing/Hiding Assays in Drop-down 

The Assays drop-down is available in other screens (e.g., Select Assay field in the Acquire tab > Setup screen and  
Assay for Recount field in the Acquire tab > Recount screen).  

1. Select one or more assays from the Assays List to be shown or hidden in the Assays drop-down by clicking  
once to highlight the first one and then holding either the Shift key (to select a block of assays) or Ctrl key  
(to select non-contiguous assays) down while clicking on additional assays.  

2. Click the Show or Hide button depending on whether you want to show/hide the selected assays in the 
Assays drop-down available in other screens. 
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EDITING AN ASSAY 

Editing an assay allows users to change basic Assay Details (such as name, description, category and product type), 
defined Imaging and Analysis parameter settings, and Reporting templates currently assigned to the assay. Not all 
options shown in this section are available for all products and instrument configurations. 

To select an assay and view its details, double-click it in the Assays List or click the assay once to highlight it and 
then click the View button located at the bottom of the screen.  

Note: The assay displayed contains many sections in which the content of each section may vary depending on the 
product type and the channels chosen to be associated with the assay. 

Edit the assay as described in each of the sections presented below: 

• Modifying Basic Assay Details on page 46 
• Defining Assay Imaging and Analysis Parameters (For Cellaca MX/PLX) on page 47 
• Defining Assay Imaging and Analysis Parameters (For Cellometer K2) on page 53 
• Managing Assay Reports and Exports on page 57 

When viewing/editing of an assay is complete, click one of the following buttons to return to the Assays List. 

 
Back Button: Click Back to return to the previous screen without saving any changes. If 
assay has unsaved changes, click OK in response to the confirmation prompt. 
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Save and Back|Save Buttons: Click Save and Back to save your changes and return to the 
previous screen. Depending on the nature of your editing session, click      to toggle the 
display of this button between Save (to save and continue editing) and Save and Back. 

 
Save As|Save As and Back Buttons: Click Save As to save your changes as a copy with a 
new name or select another assay from the drop-down to override it and return to the 
previous screen. If the assay is locked, this also allows you to copy the assay to use as a 
source for creating a new assay. Depending on the nature of your editing session, click      
to toggle the display of this button between Save As (to save current version as a copy and 
continue editing it) and Save As and Back. 

Modifying Basic Assay Details 

In the Assay Details area, you can edit the assay Name, Description, Category or Product as indicated below. 

Note: You can only edit an assay if the category displayed is Unlocked. If the category displayed is Locked or if the 
assay is a Revvity System default, you must first copy the assay by clicking the Save As button and entering a new 
name to save defined parameters as a source for creating a new assay. Once saved, you can edit copied 
parameters in the new assay as necessary. 

To edit basic assay details, modify information contained in the following fields. 

Name Displays the name of the assay. Must be unique. 

Description Displays a brief description which can be used to identify the purpose of the assay or include 
defined parameters to help users distinguish it from others presented in the Assays List. 

Category Indicates if an assay was provided as a Revvity default                                                   (i.e., System 
assays cannot be edited) or if its current status is Unlocked or Locked. When viewing details for a 
Locked or System assay, use the Save As button to enter a new name and copy defined parameters 
to be used as a source for creating a new assay.  

The locked state of an assay is displayed in the State column of the Assays List using the Revvity 
System         , Unlocked         or Locked       icons. 

If an assay is unlocked, you can select the Locked  button to prevent the assay from 
being edited by other users.  

Note: It is recommended that you do not select the Locked button until after editing is complete as 
once the assay is locked, you will no longer be able to make any changes. 
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Product Indicates product type for which the assay was created (e.g., MX, PLX, K2).  

Note: As the Matrix software is shared by multiple product families, it must account for physical 
differences between instruments. To accommodate for these differences, assay details available 
for editing may vary from what is presented in this guide based on the selected product.  

Variations in Imaging and Analysis Parameters between instruments are grouped in two sections:  

• Defining Assay Imaging and Analysis Parameters (For Cellaca MX/PLX) on page 47 
• Defining Assay Imaging and Analysis Parameters (For Cellometer K2) on page 53 

Defining Assay Imaging and Analysis Parameters (For Cellaca MX/PLX) 

This section describes assay imaging and analysis parameters in the Matrix software available for Cellaca MX/PLX. 

In the Imaging and Analysis area, you can edit defined assay parameter settings for Imaging Mode, Analysis Mode, 
Focusing Mode (if available based on product), Dilution and Channel Imaging Parameters as indicated below. 

If Imaging and Analysis parameters are not displayed, expand the area by clicking the down arrow 
to view available options.  

IMAGING MODE OPTIONS 

Edit Imaging Mode selected for the assay by clicking an imaging mode option.  

 

BR Brightfield Only − Indicates assay will use a brightfield image to determine Total Cell Concentration 
and Trypan Blue Cell Viability.  

BR/FL Brightfield/Fluorescence: Indicates assay will use single, dual or multiple channel imaging by 
analyzing fluorescent images in conjunction with their associated brightfield images. 

Number of Channels: Drop-down lists available channels for the assay (i.e., 1-6 for Cellaca MX/PLX).  

• BR/FL 1 − Brightfield Image, Single Fluorescent Image Analysis  

• BR/FL 2 − Brightfield Image, Two Fluorescent Images Analysis  

• BR/FL 3-6 − Brightfield Image, Three+ Fluorescent Images Analysis 

Note: If channels previously defined for assay will be lost as a result of a 
new imaging mode selected, you will be prompted with a confirmation 
message. Click OK to proceed or Cancel to retain current imaging mode.  
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ANALYSIS MODE OPTIONS 

In the Analysis Mode area you can edit the analysis mode selected for the assay by clicking available options (as 
shown in the screens below) and entering values for any additional fields presented.  

Note: Analysis modes displayed will vary based on the selected Imaging Mode for the assay. In addition, Channel 
Imaging and Cell Type Parameters displayed on page 51 will also vary as a result of the selected Analysis Mode. 

FOR BR ONLY IMAGING MODE 

Cell Count − Perform brightfield image analysis to determine   
Total Cell Concentration. 

Trypan Viability − Perform brightfield image analysis of   
Trypan Blue exclusion to determine Cell Viability. 

FOR BR/FL 1 CHANNEL IMAGING MODE  

Cell Count − Count cells in brightfield/fluorescent images 
independently. Allows you to select either a BR or FL mask  
to assist in finding FL positive cells. Use a fluorescent mask  
if cells are difficult to detect in brightfield images. 

Viability − Calculate cell concentration and % viability  
using a nuclear staining dye (single-fluorescence). Allows  
you to select a BR, FL or Hybrid mask to assist in finding  
FL positive cells. In addition, you can select FL Classification 
(Live or Dead).  

Use a fluorescent mask if cells are difficult to detect in  
brightfield images OR a Hybrid mask when counting FL images  
to exclude corresponding cells found in BR images (e.g., dead  
cells with faint walls that only show up using FL).  

Expression − Perform analysis using a single fluorophore (e.g., 
GFP, RFP, etc.). Allows you to select either a BR or FL mask to 
assist in finding FL positive cells. Use a fluorescent mask if cells 
are difficult to detect in brightfield images.  

You can also expand (increase Expand value) or contract  
(decrease Expand value) the mask around objects found to 
accurately collect fluorescent intensity measurements. 

Expression assays use a single mask for segmentation while pulling fluorescent values from the same area across 
all channels. By enabling the software to read FL values from cells without requiring those cells to be segmented in 
each FL channel using traditional methods, weaker FL intensities can be identified. 
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FOR BR/FL 2 CHANNEL IMAGING MODE 

Viability − Calculate cell concentrations and % viability using  
two nuclear staining dyes (dual-fluorescence). Allows you to  
select either no mask (None) or a brightfield (BR) mask to assist 
in finding FL positive cells. You can also select a FL Classification 
(Total, Live or Dead populations) for each channel.  

Total classification can only be assigned to one FL channel. If 
currently selected in one channel, selecting it in the other channel 
automatically swaps the first channel options.  

Expression − Perform analysis using dual fluorescence for  
samples with two FL stains. Allows you to select either a BR or  
FL mask to assist in finding FL positive cells. Use a fluorescent 
mask if cells are difficult to detect in brightfield images.  

You can also expand (increase Expand value) or contract  
(decrease Expand value) the mask around objects found to 
accurately collect fluorescent intensity measurements. 

Expression assays use a single mask for segmentation while pulling fluorescent values from the same area across 
all channels. By enabling the software to read FL values from cells without requiring those cells to be segmented in 
each FL channel using traditional methods, weaker FL intensities can be identified. 

FOR BR/FL 3+ CHANNEL IMAGING MODE 

Expression − Perform multi-fluorescence analysis for samples 
with three or more FL stains. Allows you to select either a BR  
or FL mask to assist in finding FL positive cells. Use a fluorescent 
mask if cells are difficult to detect in brightfield images.  

You can also expand (increase Expand value) or contract  
(decrease Expand value) the mask around objects found to 
accurately collect fluorescent intensity measurements. 

Expression assays use a single mask for segmentation while pulling fluorescent values from the same area across 
all channels. By enabling the software to read FL values from cells without requiring those cells to be segmented in 
each FL channel using traditional methods, weaker FL intensities can be identified. 
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FOCUSING MODE OPTIONS 

This section describes adjusting instrument focus using internal controls via Matrix software for Cellaca MX/PLX. 

In the Focusing Mode area, you can edit the Focus Mode for the assay by clicking an option (e.g., Focus Map,  
Auto Focus 1st Well or Auto Focus All Wells) and defining settings for any additional fields presented.  

Focus Map Performs manual focusing by using the system’s internal built-in plate layout to 
acquire images rapidly.  

 

 

Auto Focus 1st Well  Performs automatic focusing (auto focus) on the 1st well and then calculates the focus 
offset for all remaining wells. This option automatically uses the same set for all wells 
and is the fastest way to establish instrument focus.  

 

Select the Auto Focus Image (e.g., BR, FL1-FL6 based on number of channels in assay) 
to choose the image to be used during auto focus. 

Auto Focus All Wells Performs automatic focusing (auto focus) on all wells allowing the system to 
determine the best focus/image quality for each individual well.  

 

Select the Auto Focus Image (e.g., BR, FL1-FL6 based on number of channels in assay) 
to choose the image to be used during auto focus. 

DILUTION FACTOR 

In the Dilution area, you can edit the final dilution factor by clicking in the field and modifying the displayed value.  
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CHANNEL IMAGING AND CELL TYPE PARAMETERS 

Channel Imaging Parameters are grouped using tabs and display will vary based on the selected Imaging Mode 
(i.e., Channel 1 tab is displayed for BR or BR/FL 1 imaging modes, and Channel 2 - Channel 6 tabs are displayed for 
the BR 2-6/FL 2-6). 

Note: Channel 1 refers to BR only or BR1|FL1 images taken by the instrument’s camera during a scan through the 
first specified filter pair and Channels 2-6 refer to the BR 2-6|FL 2-6 images taken through additional filter pairs. 

You can edit Channel Imaging Parameters (e.g., Brightfield, Fluorescence and Filters) for the assay. If Channel 1 and 
Channel 2 tabs are available, toggle between the display for each channel by clicking on the applicable tab. 
Channel 1 Imaging Parameters are displayed by default.  

  

Brightfield Use Custom Exposure − Indicates if custom exposure factors are being used for the channel. 
Click Yes to edit value in the Custom Exposure Factor field (below). 

Custom Exposure Factor − Value prolongs or shortens exposure time for brightfield image. 

Fluorescence Fluorophore Name − Displays fluorophore name being used for the channel. 

Exposure (ms) − Value indicates exposure time for fluorescent image. 

Filters Excitation (365, 470, 531, 620) − Indicates excitation filter wavelength used for the channel.  

Emission (452, 534, 605, 655, 692) − Indicates emission filter wavelength used for the 
channel. 

 

In addition, you can edit Cell Type Parameters used for the channel by changing the currently selected cell type 
(i.e., use the drop-down to choose another cell type) and clicking the View button to modify cell type parameters.  

Note: When using the Viability Analysis Mode, cell type parameters can be set independently for each channel. 
However, when using the Expression Analysis Mode with more than one channel, cell type parameters are only 
required for Channel 1. 
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To manage cell types available on your instrument system or to edit/create cell types, see Chapter 7. Managing 
Cell Types on starting on page 61.  

If you click the View button to modify cell type parameters, whether you can edit parameter settings displayed will 
depend on the cell type’s Locked State indicated in the Cell Type Details section. 

Note: You can only edit parameter settings for cell types that are Unlocked. However, for Revvity System or Locked 
cell types you can click the Save As button located at the bottom of the screen to save cell type parameters by 
entering a new name and clicking Save, then edit its parameter settings accordingly. When you click Save and 
Back, the cell type currently selected has been automatically updated to the cell type you just saved/modified. 

If the cell type is Unlocked you can edit parameter settings and then click Save and Back to save your changes. See 
Editing a Cell Type on page 65 for more information on editing cell type parameter settings. 
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Defining Assay Imaging and Analysis Parameters (For Cellometer K2) 

This section describes assay imaging and analysis parameters in the Matrix software available for Cellometer K2. 

In the Imaging and Analysis area, you can edit defined assay parameter settings for Imaging Mode, Analysis Mode, 
Focusing Mode (if available based on product), Dilution and Channel Imaging Parameters as indicated below. 

If Imaging and Analysis parameters are not displayed, expand the area by clicking the down arrow 
to view available options.  

IMAGING MODE OPTIONS 

Edit Imaging Mode selected for the assay by clicking an imaging mode option. 

 

BR Brightfield Only: Indicates assay will use a brightfield image to determine Total Cell Concentration 
and Trypan Blue Cell Viability.  

BR/FL Brightfield/Fluorescence: Indicates assay will use single or dual channel imaging by analyzing 
fluorescent images in conjunction with their associated brightfield images. 

Number of Channels: Drop-down lists available channels for the assay (i.e., 1-2 for Cellometer K2).  

• BR/FL 1 − Brightfield Image, Single Fluorescent Image Analysis  

• BR/FL 2 − Brightfield Image, Two Fluorescent Image Analysis  

Note: If channels previously defined for assay will be lost as a result of a 
new imaging mode selected, you will be prompted with a confirmation 
message. Click OK to proceed or Cancel to retain current imaging mode.  

ANALYSIS MODE OPTIONS 

In the Analysis Mode area you can edit the analysis mode selected for the assay by clicking available options (as 
shown in the screens below) and entering values for any additional fields presented.  

Note: Analysis modes displayed will vary based on the selected Imaging Mode for the assay. In addition, Channel 
Imaging and Cell Type Parameters displayed on page 51 will also vary as a result of the selected Analysis Mode. 

FOR BR ONLY IMAGING MODE 

Cell Count − Perform brightfield image analysis to determine   
Total Cell Concentration. 

Trypan Viability − Perform brightfield image analysis of   
Trypan Blue exclusion to determine Cell Viability. 
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FOR BR/FL 1 CHANNEL IMAGING MODE  

Cell Count − Count cells in brightfield/fluorescent images 
independently. Allows you to select either a BR or FL mask  
to assist in finding FL positive cells. Use a fluorescent mask  
if cells are difficult to detect in brightfield images. 

Viability − Calculate cell concentration and % viability  
using a nuclear staining dye (single-fluorescence). Allows  
you to select a BR, FL or Hybrid mask to assist in finding  
FL positive cells. In addition, you can select FL Classification 
(Live or Dead).  

Use a fluorescent mask if cells are difficult to detect in  
brightfield images OR a Hybrid mask when counting FL images  
to exclude corresponding cells found in BR images (e.g., dead  
cells with faint walls that only show up using FL).  

Expression − Perform analysis using a single fluorophore (e.g., 
GFP, RFP, etc.). Allows you to select either a BR or FL mask to 
assist in finding FL positive cells. Use a fluorescent mask if cells 
are difficult to detect in brightfield images.  

You can also expand (increase Expand value) or contract  
(decrease Expand value) the mask around objects found to 
accurately collect fluorescent intensity measurements. 

Expression assays use a single mask for segmentation while pulling fluorescent values from the same area across 
all channels. By enabling the software to read FL values from cells without requiring those cells to be segmented in 
each FL channel using traditional methods, weaker FL intensities can be identified. 

FOR BR/FL 2 CHANNEL IMAGING MODE 

Viability − Calculate cell concentrations and % viability using  
two nuclear staining dyes (dual-fluorescence). Allows you to  
select either no mask (None) or a brightfield (BR) mask to assist 
in finding FL positive cells. You can also select a FL Classification 
(Total, Live or Dead populations) for each channel.  

Total classification can only be assigned to one FL channel. If 
currently selected in one channel, selecting it in the other channel 
automatically swaps the first channel options.  
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Expression − Perform analysis using dual fluorescence for  
samples with two FL stains. Allows you to select either a BR or  
FL mask to assist in finding FL positive cells. Use a fluorescent 
mask if cells are difficult to detect in brightfield images.  

You can also expand (increase Expand value) or contract  
(decrease Expand value) the mask around objects found to 
accurately collect fluorescent intensity measurements. 

Expression assays use a single mask for segmentation while pulling fluorescent values from the same area across 
all channels. By enabling the software to read FL values from cells without requiring those cells to be segmented in 
each FL channel using traditional methods, weaker FL intensities can be identified. 

DILUTION FACTOR 

In the Dilution area, you can edit the final dilution factor by clicking in the field and modifying the displayed value.  

CHANNEL IMAGING AND CELL TYPE PARAMETERS 

Channel Imaging Parameters are grouped using tabs and display will vary based on the selected Imaging Mode 
(i.e., Channel 1 tab is displayed for BR or BR/FL 1 imaging modes, and Channel 2 tab is displayed for BR/FL 2). 

Note: Channel 1 refers to BR only or BR1|FL1 images taken by the instrument’s camera during a scan through the 
first filter set and Channel 2 refers to the BR2|FL2 images taken through the second filter set. 

You can edit Channel Imaging Parameters (e.g., Brightfield, Fluorescence and Filters) for the assay. If Channel 1 and 
Channel 2 tabs are available, toggle between the display for each channel by clicking on the applicable tab. 
Channel 1 Imaging Parameters are displayed by default. 
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Brightfield Use Custom Exposure − Indicates if custom exposure factors are being used for the channel. 
Click Yes to edit value in the Custom Exposure Factor field (below). 

Custom Exposure Factor − Value prolongs or shortens exposure time for brightfield image. 

Fluorescence Fluorophore Name − Displays fluorophore name being used for the channel. 

Exposure (ms) − Value indicates exposure time for fluorescent image. 

Filters 535 − Excitation 470 nm/Emission 535 nm  

660 − Excitation 540 nm/Emission 660 nm 
 

In addition, you can edit Cell Type Parameters used for the channel by changing the currently selected cell type 
(i.e., use the drop-down to choose another cell type) and clicking the View button to modify cell type parameters.  

Note: When using the Viability Analysis Mode, cell type parameters can be set independently for each channel. 
However, when using the Expression Analysis Mode with more than one channel, cell type parameters are only 
required for Channel 1. 

To manage cell types available on your instrument system or to edit/create cell types, see Chapter 7. Managing 
Cell Types on starting on page 61.  

If you click the View button to modify cell type parameters, whether you can edit parameter settings displayed will 
depend on the cell type’s Locked State indicated in the Cell Type Details section. 
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Note: You can only edit parameter settings for cell types that are Unlocked. However, for Revvity System or Locked 
cell types you can click the Save As button located at the bottom of the screen to save cell type parameters by 
entering a new name and clicking Save, then edit its parameter settings accordingly. When you click Save and 
Back, the cell type currently selected has been automatically updated to the cell type you just saved/modified. 

If the cell type is Unlocked you can edit parameter settings and then click Save and Back to save your changes. See 
Editing a Cell Type on page 65 for more information on editing cell type parameter settings. 

Managing Assay Reports and Exports 

In the Reports and Exports area you can assign report templates to control how data is displayed, exported and 
printed. In addition to the Well View tab which will always be displayed, a total of five (5) custom reporting tabs 
may be enabled for display at any one time.  

Note: As of the Matrix v4.0 release, report templates are no longer limited to the Display, Export or Print template 
types used in earlier releases. A report template can be created for all these purposes and multiple templates 
assigned to an assay as needed. In addition, report tabs enabled by default will vary based on the Matrix software 
version associated with an assay (e.g., Well View, Summary and .csv tabs are displayed for v4.0 assays; Well View 
and All Wells tabs for v3.0 assays). Users can change report templates assigned to these tabs, edit the templates 
directly (i.e., any changes made will also be applied to other scan results using these templates), disable them from 
displaying as tabs or delete them from the assay. 

If Imaging and Analysis parameters are not displayed, expand the area by clicking the down arrow  
to view available options. 

To change the report template currently assigned to the Well View tab, use the Display drop-down to select a new 
template. Click View to confirm the selected template suits your display needs and edit it if necessary.  
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To define assay Exports such as Images, Data and Archive output files (i.e., exported automatically after analysis is 
complete), select any of the following options. 

Raw Images  Represents Black and White high-resolution PNG images. 

Colorized Images Represents Fluoresced high-resolution PNG images. 

Well Level CSV  Represents well-level data including well name, calculation run, channel, count, mean size, 
etc. for each selected well in Comma Separated Values (CSV) format. 

Object Level CSV Represents object-level data including type, classification, size, circularity, area, perimeter, 
etc. in Comma Separated Values (CSV) format. 

Object Level ACS Represents object-level data including type, classification, size, circularity, area, perimeter, 
etc. in Image Cytometry Experiment (ICE) format. Data may be associated with an ACS 
template for import into the De Novo Software FCS Express application. See Chapter 8. 
Managing ACS Templates starting on page 71. 

Data Set  Represents a database file containing all images, results, assays, cell types and report 
templates associated with the scan result. 

To select a report template and edit how it is being applied to an assay, double-click it in the Reports area, or click 
on a report in the list once to highlight it and then click the View button.  

You can use report tab options to disable/enable the display of report templates as tabs and edit/enter tab names. 
A total of five (5) custom tabs may be enabled for display at any one time. In addition, you can select output file 
types for report templates and indicate if files are to be opened automatically or printed upon report generation. 
Click the Update Report button to save your changes and view the updated Reports List. 
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To manage this list for an assay, select a template and click the Create/Delete or Move Up/Move Down buttons.  

• Add a report template by clicking the Create button. Select a template in the Report Template field, choose if 
the report should be enabled as a tab for display (i.e., Yes) and enter a tab name. Select any output file types 
for the report and indicate if they are to be opened automatically (Auto Open) or printed upon generation 
whenever the assay is used to perform a count/recount. Output of files is independent of whether a template 
is also enabled as a tab. Click the Add Report button to add the report to the Reports List.  

• Delete a template by clicking on the report once to highlight it and then clicking the Delete button.  
If report template deleted was from the Report Template Library provided with the Matrix software, it can be 
re-imported if necessary. If report template was from a custom library or created using the Matrix software, it 
may be permanently deleted unless it was exported to an external location and saved prior to deletion.  

• Change the order in which report tabs are displayed by changing the sequence of templates in the Report List. 
Highlight a report template to select it and click the Move Up or Move Down buttons accordingly. 

For complete step-by-step instructions on setting reporting options for an assay such as changing the display 
template in the Well View report, managing an assay Report List or adding report templates, see Chapter 5. 
Customizing Scan Result Reports starting on page 33 for details. 
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CREATING A NEW ASSAY 

You can create a new assay by clicking the Manage tab > Assays option to display the Assays List and then clicking 
the Create button located at the bottom of the screen.  

Enter basic Assay Details (such as name, description, category and product type), Imaging and Analysis parameter 
settings and Reporting options, and then click the Save and Back button to add the assay to the Assays List. 

To copy defined parameter settings for an existing assay to be used as a source for creating a new assay, select an 
assay and view its details by double-clicking it in the Assays List or clicking it once to highlight it and then clicking 
the View button located at the bottom of the screen. Click the Save As button and enter a new name to save a 
copy of the assay, and then click the Save button.  

Edit assay parameters as described in Editing an Assay on page 45 and click the Save and Back button to confirm 
that the new assay has been saved to the Assays List.  
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Chapter 7. Managing Cell Types 

This chapter describes how cell types are displayed in the Cell Types List and how to manage the list to keep it current. 
Details on how to edit and create cell types are also provided. Cell type parameters can be optimized to meet your 
data acquisition needs. 

Note: When migrating to the Matrix database from an earlier version, updated cell types can be imported via the 
software after migration is complete. For a list of cell types provided with the Matrix software or for assistance in 
defining a custom cell type, contact Support by visiting https://www.revvity.com/contact-us or send email to:  
CellC-support@revvity.com 

VIEWING THE CELL TYPES LIST 

You can manage cell types for your instrument system by clicking the Manage tab > Cell Types option to view the 
Cell Types List. From this screen you can import/export, rename and delete cell types appearing in the Cell Types List, 
as well as show/hide cell types displayed in the Cell Types drop-down appearing in other screens.  

In addition, you can select a cell type from the list to view/edit its details, create a new cell type by defining custom 
parameter settings or use a locked cell type as a source for creating a new cell type based on its parameter settings.  

Note: If the Matrix 21 CFR Part 11 module is enabled, the Create button (and Save and Back button when viewing 
cell type details) will only be available for users who have been granted permission to perform these functions. 

Use the Per Page  control to change the number of cell types displayed per page and the                       
arrows to move back and forth between pages in the list. 

Cell types can be sorted by clicking on column headings (i.e., ascending         /descending         indicators will be 
displayed), and information presented for each cell type includes name, description and created/last modified dates.  

Icons displayed in the State column indicate whether a cell type was provided as a Revvity System         standard  
(which cannot be edited) or if a cell type is currently Locked       or Unlocked        . When viewing System and Locked 
cell types, a Save As button allows users to copy defined parameter settings as a source for creating a new cell type. 

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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The remaining columns display checkmarks      for the cell type based on the conditions noted below: 

• A checkmark displayed in the Shown column indicates the cell type is to be included in the Cell Type drop-down 
available in other screens (e.g., Cell Type Parameters field in the Manage tab > Assay Details screen). 

• A checkmark displayed in the Linked by Assay column indicates the cell type is associated with an assay. Cell 
types must be unlinked from all assays before they can be deleted.  

• A checkmark displayed in the Inherited State column indicates the cell type was locked prior to importing it into 
your instrument library (i.e., its Locked State was inherited during import). Keep in mind that cell types may be 
imported directly via the Manage tab > Cell Types screen or as components when importing assays/datasets.  

SEARCHING FOR CELL TYPES 

To search for a cell type, enter a few key characters of a cell type name or description in the Search field and/or 
expand the Filters area by clicking the down arrow               to specify search criteria. 

As you choose filters (e.g., by selecting Category, Shown or Linked By Assay options) or enter a Created Between/ 
Modified Between range of dates, the Cell Types List is updated automatically to display matching entries.  

Category Choose from the following categories: 

Unlocked − Filters for cell types that are unlocked and can be edited 
Locked − Filters for cell types that are locked and cannot be edited 
System − Filters for cell types provided by Revvity (locked and cannot be edited) 

System cell types are no longer available in the Cell Type Library provided with the 
Matrix software but may exist on your system if imported from an earlier release. 

Shown Choose from the following Shown states: 

Shown − Filters for cell types selected to appear in the Cell Types drop-down 
Hidden − Filters for cell types that do not appear in the Cell Types drop-down  

Note: The Cell Types drop-down is available in other screens (e.g., Cell Type 
Parameters field in the Assay Details screen).  

Linked By Assay Choose from the following Linked by Assay states: 

Linked − Filters for cell types that are currently associated with an assay 
Not Linked − Filters for cell types that are not currently associated with an assay  

Cell types must be unlinked from all assays before they can be deleted.  
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Created Between Enter a Created Between range indicating the start/end dates between which to filter 
for cell types created in that time frame. 

Modified Between Enter a Modified Between range indicating the start/end dates between which to filter 
for cell types modified in that time frame. 

If you find it necessary to clear all selected filters and begin the search again, click the Reset button. 

To select a cell type and view its details, double-click it in the Cell Types List or click the cell type once to highlight it 
and then click the View button located at the bottom of the screen. 

MAINTAINING THE CELL TYPES LIST 

When you select a cell type, buttons at the top of the Cell Types List become available to perform the following 
functions. The Import button will always be enabled as it does not require the selection of a cell type in your library. 

Note: If the Matrix 21 CFR Part 11 module is enabled, buttons will only be available for users who have been granted 
permission to perform specific functions. 

Importing Cell Types 

1. While viewing the Cell Types List, click the  
Import button.  

2. Navigate to a folder where an external cell type library 
is available or a cell type was previously saved.  

3. Select one or more .CELLTYPE files to be imported.  

4. Click Open. If selected cell types already exist in your  
database, respond to the confirmation prompt by  
clicking Yes to overwrite the file in your system or  
No to abort the import. If you choose No you will be 
prompted to enter a new name under which to import 
the cell type (and then click Rename) or click Cancel to 
abort the import.  

Note: When importing a System or Locked cell type,  
you will be prompted to import it under a different  
name. Click Yes, enter a new name and click Rename  
to complete the import. 

5. Click OK to acknowledge the successful import and  
confirm that imported cell types are displayed in the  
Cell Types List. 
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Exporting Cell Types 

1. Select one or more cell types from the Cell Types List 
to be exported by clicking once to highlight the first one 
and then holding either the Shift key (to select a block of  
cell types) or Ctrl key (to select non-contiguous cell 
types) down while clicking additional cell types.  

2. Click the Export button. 

3. Navigate to a folder where cell types are to be saved.  

4. Click OK to save .CELLTYPE files in the export location.  

Renaming Cell Types 

The Rename button will only be available for unlocked cell types.  

1. Select the cell type to be renamed and click the  
Rename button.  

2. Edit the cell type name and click Rename to save  
your changes.  

Deleting Cell Types 

1. Select one or more cell types from the Cell Types List 
to be deleted by clicking once to highlight the first one 
and then holding either the Shift key (to select a block 
of cell types) or Ctrl key (to select non-contiguous cell 
types) down while clicking on additional cell types.  

2. Click the Delete button. If the Matrix 21 CFR Part 11 
module is enabled, users will be prompted to enter a  
reason prior to deletion. 

Note: If cell types to be deleted were from the Cell Type Library provided with the Matrix software, they can be  
re-imported if necessary. If cell types were from a custom library or created using the Matrix software, they may 
be permanently deleted unless cell types were exported to an external location and saved prior to deletion. 

Cell types must be unlinked from all assays before they can be deleted.  

Showing/Hiding Cell Types in Drop-down 

The Cell Types drop-down is available in other screens (e.g., Cell Type Parameters field in the Assay Details screen). 

1. Select one or more cell types from the Cell Types List to be shown or hidden in the Cell Types drop-down by 
clicking once to highlight the first one and then holding either the Shift key (to select a block of cell types) or  
Ctrl key (to select non-contiguous cell types) down while clicking on additional cell types.  
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2. Click the Show or Hide button depending on whether you want to show/hide the selected cell types in the 
Cell Types drop-down available in other screens.  

EDITING A CELL TYPE 

Editing a cell type allows users to change basic Cell Type Details (such as name, description and locked state), defined 
Brightfield Parameters settings and Fluorescence Parameters settings. 

To select a cell type and view its details, double-click it in the Cell Types List or click the cell type once to highlight it 
and then click the View button located at the bottom of the screen.  

Edit the cell type as described in each of the sections presented below: 

• Basic Cell Type Details on page 66 
• Brightfield Parameters on page 67 
• Fluorescence Parameters on page 69 

When viewing/editing of a cell type is complete, click one of the following buttons to return to the Cell Types List. 

 
Back Button: Click Back to return to the previous screen without saving any changes. If cell 
type has unsaved changes, click OK in response to the confirmation prompt. 
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Save and Back|Save Buttons: Click Save and Back to save your changes and return to the 
previous screen. Depending on the nature of your editing session, click      to toggle the 
display of this button between Save (to save and continue editing) and Save and Back. 

 
Save As|Save As and Back Buttons: Click Save As to save your changes as a copy with a 
new name or select another cell type from the drop-down to override it and return to the 
previous screen. If the cell type is locked, this also allows you to copy the cell type to use as 
a source for creating a new cell type. Depending on the nature of your editing session, click 
     to toggle the display of this button between Save As (to save current version as a copy 
and continue editing it) and Save As and Back. 

Basic Cell Type Details 

In the Cell Type Details area, you can edit the cell type Name, Description and Locked State as indicated below. 

Note: You can only edit a cell type if the category displayed is Unlocked. If the category displayed is Locked or if the 
cell type is a Revvity System default, you must first copy the cell type by clicking the Save As button and entering a 
new name to save defined parameters as a source for creating a new cell type. Once saved, you can edit copied 
parameters for the new cell type as necessary.  

To edit basic cell type details, modify information contained in the following fields. 

Name Displays the name of the cell type. Must be unique. 

Description Displays a brief description which can be used to identify the cell type or include defined 
parameters to help users distinguish it from others presented in the Cell Types List. 

Locked State Indicates if a cell type was provided as a Revvity default                                                   (i.e., System 
cell types cannot be edited) or if its current status is Unlocked or Locked. When viewing details 
for a Locked or System cell type, use the Save As button to copy defined parameters as a source 
to be used for creating a new cell type.  

The locked state of a cell type is displayed in the State column of the Cell Types List using the 
Revvity System         , Unlocked             or  Locked       icons. 

If a cell type is unlocked, you can select the Locked                           button to prevent the cell type 
from being edited by other users.  

Note: It is recommended that you do not select the Locked button until after editing is complete 
as once the cell type is locked, you will no longer be able to make any changes. 
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Brightfield Parameters 

In the Brightfield Parameters area, you can edit defined settings for Cell Attributes, Declustering and Trypan Blue 
parameters as indicated below.  

Cell Attributes  

Defines basic brightfield parameter attributes for cells to be counted. 

Cell Diameter (µm) Indicates range of cell diameter minimum to maximum 
values to be counted. Cells with diameters that fall 
outside of this range will not be counted.  

Roundness Indicates minimum cell shape roundness factor to be 
counted. Values range from 0.00 (includes all cell 
shapes) to 1.00 (includes only perfectly round cells). 

Contrast 
Enhancement 

Defines contrast enhancement value for cells in relation 
to the background. Values range from 0.00 (cells with 
high contrast to background) to 0.80 (cells with low 
contrast to background); recommended value is 0.4.  

Declustering  

Defines whether individual cells within a clump are to be counted. Turning this feature off allows clumps to be 
counted as one unit if its diameter falls within the minimum/maximum cell diameter range. The Yes button indicates 
declustering parameters are to be used (enabled by default). Click No to turn OFF declustering.  

Edge Factor Indicates degree to which cell edges must be enhanced 
for optimal declustering. Values range from 0.0 (clearly 
defined edges) to 1.0 (edges difficult to distinguish from 
the background).  

Threshold Factor Indicates threshold ratio between cell signal and 
background. Values range from 0.0 (cell signal to 
background is very low) to 1.0 (cell signal to background 
is high). Lower values help to normalize ‘noise’ from 
fluorescent signals. 

Background 
Adjustment 

Indicates the adjustment ratio between cell signal and 
background. Values range from 0.0 (cell signal to 
background is very low) to 1.0 (cell signal to background 
is high). Lower values help to normalize ‘noise’ from 
brightfield signals. 
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Trypan Blue 

Defines trypan blue viability cell detection parameter settings for cells to be counted.  

Dead Cell Diameter 
(µm) 

Indicates range of dead cell diameter minimum to 
maximum values to be counted. Dead cells with 
diameters that fall outside of this range will not be 
counted. 

Sensitivity Adjusts sensitivity of the camera to darkness level of 
trypan blue stained cells to be counted. Values range 
from 0.00 (detects very dark stained cells) to 10.0 
(detects more mixed staining populations).  

Uniformity Indicates trypan blue staining uniformity to be counted. 
Values range from 100 (stained cells are all uniform in 
color) to 255 (stained cells have non-uniform dark and 
light areas). 

Very Dim Dead Cells When feature is enabled (Yes), helps to detect very dim 
stained dead cells. 

Contrast 
Enhancement 

Very Dim Dead Cells feature must be selected for this 
field to be enabled. Refines the division between the 
background and cells with low contrast (i.e., no defined 
edges). Suggested enhancement value is 0.60; values 
range from 0.00 (stained cells have medium contrast to 
background) to 0.80 (stained cells have very low 
contrast to background). 
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Fluorescence Parameters  

Defines fluorescent parameter attributes for cells to be counted.  

Cell Diameter (µm) Indicates range of cell diameter minimum to maximum 
values to be counted. Cells with diameters that fall 
outside of this range will not be counted. 

Normalize Intensity 
for Cell Size 

When feature is enabled (Yes), adjusts fluorescent 
intensity to the size of the cell. For example, if cells 
don’t uptake the staining all at once and both light and 
dark areas exist within cells, enabling this feature 
normalizes FL intensity throughout the entire cell rather 
than having multiple intensity readings. 

 

Non-Uniform Cells When feature is enabled (Yes), identifies a cell as 
positive even if only a portion of the cell has 
fluorescence intensity above the defined threshold. 
Enabling this feature is useful if cells in the sample have 
a mixed staining population that contains both light and 
dark areas. 

Roundness Indicates minimum cell shape roundness factor to be 
counted. Values range from 0.00 (includes all cell 
shapes) to 1.0 (includes only perfectly round cells). 

Do Not Count Free 
Nuclei 

When feature is enabled (Yes), uses a proprietary image 
analysis algorithm that excludes free floating nuclei 
from being counted as cells. 

Advanced BR/F 
Mode 

When feature is enabled (Yes), uses a proprietary 
counting method combining brightfield and 
fluorescence imaging to perform enhanced 
declustering. 

 

Thresholding  

Indicates fluorescence intensity required for cells to be counted.  

% of Image Range  
to Count 

Defines percentage of FL threshold to be counted. 

For Manual thresholding, entering a value in this field 
defines the percentage of pixels to be counted thus 
excluding cells that fall below that value. Values range 
from 1-100.  
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For Auto thresholding, this feature establishes 
maximum intensity of all images taken for the sample 
to be 100%. Entering a value in this field defines a 
percentage of that maximum (e.g., 10 %) thus excluding 
cells with an intensity that fall below that value.  

A general rule is to lower the threshold value to include 
dim cells or increase threshold value to exclude cells. 

Threshold Factor Indicates threshold ratio between cell signal and 
background. Values range from 0.0 (cell signal to 
background is very low) to 1.0 (cell signal to background 
is high). Lower values help to normalize ‘noise’ from 
fluorescent signals. 

CREATING A NEW CELL TYPE 

You can create a new cell type by clicking the Manage tab > Cell Types option to display the Cell Types List and then 
clicking the Create button located at the bottom of the screen.  

Enter basic Cell Type Details (such as name, description and locked state), define Brightfield Parameters settings and 
Fluorescence Parameters settings, and then click the Save and Back button to add the cell type to the Cell Types List. 

To copy defined parameter settings for an existing cell type to be used as a source for creating a new cell type, select 
a cell type and view its details by double-clicking it in the Cell Types List or clicking it once to highlight it and then 
clicking the View button located at the bottom of the screen. Click the Save As button and enter a new name to save 
a copy of the cell type, and then click the Save button. 

Edit cell type parameters as described in Editing a Cell Type on page 65 and click the Save and Back button to confirm 
that the new cell type has been saved to the Cell Types List.  
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Chapter 8. Managing ACS Templates 

This chapter describes how ACS templates are displayed in the ACS Templates List and how to manage the list to 
keep it current. ACS templates can be assigned to assays if the Object Level ACS export option is selected.  

ACS templates can be assigned to assays as an output file type when exported data in Image Cytometry Experiment 
(ICE) format is to be imported into the De Novo Software FCS Express application. 

VIEWING THE ACS TEMPLATES LIST 

You can manage ACS templates available to your instrument system by clicking the Manage tab > ACS Templates 
option to view the ACS Templates List. From this screen you can import/export, rename and delete ACS templates 
appearing in the ACS Templates List, as well as show/hide ACS templates displayed in the ACS Templates drop-
down appearing in other screens.  

Note: ACS templates can only be created, edited and viewed in the De Novo Software FCS Express application and 
then imported via the Matrix software for your instrument system. In addition, no verification is performed on ACS 
templates other than checking for the .FEY file extension. 

Use the Per Page  control to change the number of ACS templates displayed per page and the 

 arrows to move back and forth between pages in the list. 

ACS Templates can be sorted by clicking on column headings (i.e., ascending  /descending  indicators will be 
displayed), and information presented for each template includes name and created/last modified dates.  

The remaining columns display checkmarks      for the ACS template based on the conditions noted below: 

• A checkmark displayed in the Shown column indicates the ACS template is to be included in the ACS Templates 
drop-down available in other screens (e.g., in Reports and Exports/Data section of Assay Details screen). 

• A checkmark displayed in the Linked by Assay column indicates the ACS template is associated with an assay. 
ACS templates must be unlinked from all assays before they can be deleted.  
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• A checkmark displayed in the Inherited State column indicates the ACS template was locked prior to importing 
it into your instrument library (i.e., its Locked State was inherited during import). Keep in mind that ACS 
templates may be imported directly via the Manage tab > ACS Templates screen or as components when 
importing assays/datasets.  

SEARCHING FOR ACS TEMPLATES 

To search for an ACS template, enter a few key characters of an ACS template name or description in the Search 
field and/or expand the Filters area by clicking the down arrow               to specify search criteria.  

As you choose filters (e.g., by selecting Category, Shown or Linked By Assay options) or enter a Created Between/ 
Modified Between range of dates, the ACS Templates List is updated automatically to display matching entries.  

Category Choose from the following categories: 

Unlocked − Filters for ACS templates that are unlocked and can be edited 
Locked − Filters for ACS templates that are locked and cannot be edited 
System − Filters for ACS templates provided by Revvity (locked and cannot be edited) 
 

System ACS templates may not be included in a release. 

Shown Choose from the following Shown states: 

Shown − Filters for ACS templates selected to appear in ACS Templates drop-down 
Hidden − Filters for ACS templates that do not appear in ACS Templates drop-down  

The ACS Templates drop-down is available in other screens (e.g., in Reports and Exports/ 
Data section of the Assay Details screen).  

Linked By Assay Choose from the following Linked by Assay states: 

Linked − Filters for ACS templates that are currently associated with an assay 
Not Linked − Filters for ACS templates that are not currently associated with an assay  

ACS Templates must be unlinked from all assays before they can be deleted.  

Created Between Enter a Created Between range indicating the start/end dates between which to filter  
for ACS templates created in that time frame. 

Modified Between Enter a Modified Between range indicating the start/end dates between which to filter for  
ACS templates modified in that time frame. As ACS Templates cannot be modified in the 
Matrix software, modification dates for templates file are updated only when you overwrite an 
existing file on import. 

If you find it necessary to clear all selected filters and begin the search again, click the Reset button. 
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MAINTAINING THE ACS TEMPLATES LIST 

When you select an ACS template, buttons at the top of the ACS Templates List become available to perform the 
following functions. The Import button will always be enabled as it does not require selection of an ACS template in 
your library. 

Note: If the Matrix 21 CFR Part 11 module is enabled, buttons will only be available for users who have been 
granted permission to perform specific functions.  

Importing ACS Templates 

1. While viewing the ACS Templates List, click the 
Import button.  

2. Navigate to a folder where an ACS template library is 
available or an ACS template was previously saved.  

3. Select one or more .FEY files to be imported. 

4. Click Open. If selected ACS templates already exist  
in your database, respond to the confirmation prompt   
by clicking Overwrite to overwrite the file in your   
system, Auto-Rename to automatically add “(#)” to  
the end of the file name indicating the imported file is  
a copy (where # represents a value of 1, 2, 3, etc.) or  
Cancel to abort the import.  

5. Click OK to acknowledge the successful import and  
confirm that imported ACS templates are displayed 
in the ACS Templates List. 

Exporting ACS Templates 

1. Select one or more ACS templates from the 
 ACS Templates List to be exported by clicking once to 
highlight the first one and then holding either the 
Shift key (to select a block of templates) or Ctrl key  
(to select non-contiguous templates) down while 
clicking additional ACS templates. 

2. Click the Export button. 

3. Navigate to a folder where ACS templates are 
 to be saved.  

4. Click OK to save .FEY files in the export location.  
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Renaming ACS Templates 

1. Select the ACS template to be renamed and click the  
Rename button.  

1. Edit the ACS template name and click Rename to save  
your changes. 

Deleting ACS Templates   

1. Select one or more ACS templates from the ACS Template 
List to be deleted by clicking once to highlight the first one 
and then holding either the Shift key (to select a block of 
templates) or Ctrl key (to select non-contiguous templates) 
down while clicking on additional ACS templates.  

Click the Delete button followed by Yes to confirm the action.  

If the Matrix 21 CFR Part 11 module is enabled, users will be prompted to enter a reason prior to deletion. 

Note: If ACS template deleted was from the ACS Template Library provided with the Matrix software, it 
can be re-imported if necessary. If ACS template was from a custom library, it may be permanently deleted 
unless ACS template was exported to an external location and saved prior to deletion. 

ACS Templates must be unlinked from all assays before they can be deleted. 

Showing/Hiding ACS Templates in Drop-down 

The ACS Templates drop-down is available in other screens (e.g., in Reports and Exports/Data section of Assay 
Details screen).  

1. Select one or more ACS templates from the ACS Templates List to be shown or hidden in the ACS Templates 
drop-down by clicking once to highlight the first one and then holding either the Shift key (to select a block of 
templates) or Ctrl key (to select non-contiguous templates) down while clicking on additional ACS templates.  

2. Click the Show or Hide button depending on whether you want to show/hide the selected ACS templates in 
the ACS Templates drop-down available in other screens. 
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Chapter 9. Managing Report Templates 

This chapter describes how report templates are displayed in the Report Templates List and how to manage the list 
to keep it current. An overview on how to edit and create report templates is also provided. Report templates are 
used to display, export and print data, and can be customized to meet your reporting needs. 

Note: When migrating to the Matrix database from an earlier version, updated report templates can be imported 
via the software after migration is complete. For list of report templates provided with Matrix software or for 
assistance in defining a custom report template, contact Support by visiting https://www.revvity.com/contact-us 
or send email to: CellC-support@revvity.com 

VIEWING THE REPORT TEMPLATES LIST 

You can manage report templates for your instrument system by clicking the Manage tab > Report Templates 
option to view the Report Templates List. From this screen you can import/export, rename and delete report 
templates appearing in the Report Templates List, as well as show/hide report templates displayed in the  
Report Templates drop-down appearing in other screens. 

In addition, you can select a report template from the list to view/edit its details, create a new report template by 
adding custom report elements/defining parameter settings, or use a locked report template as a source for 
creating a new report template based on its elements/parameter settings.  

Note: If the Matrix 21 CFR Part 11 module is enabled, the Create button (and Save and Back button when viewing 
report templates) will only be available for users who have been granted permission to perform these functions. 

Use the Per Page  control to change the number of report templates displayed per page and the 
                      arrows to move back and forth between pages in the list. 

Report Templates can be sorted by clicking on column headings (i.e., ascending         /descending         indicators will 
be displayed), and information presented for each report template includes name, description, imaging mode/ 
number of channels, analysis mode defined for the report template and created/last modified dates.  

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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Icons displayed in the State column indicate whether a report template was provided as a Revvity System          
standard (which cannot be edited) or if a report template is currently Locked       or Unlocked        . When viewing 
System and Locked report templates, a Save As button allows users to copy report elements and defined 
parameter settings as a source for creating a new report template. 

The remaining columns display checkmarks      for the report template based on the conditions noted below: 

• A checkmark displayed in the Shown column indicates the report template is to be included in the Templates 
drop-downs available in other screens (e.g., Display Template, Print Template and Export Template fields in 
the Assay Details screen). 

• A checkmark displayed in the Linked by Assay column indicates the report template is associated with an 
assay. Report templates must be unlinked from all assays before they can be deleted.  

• A checkmark displayed in the Inherited State column indicates the report template was locked prior to 
importing it into your instrument library (i.e., its Locked State was inherited during import). Keep in mind that 
report templates may be imported directly via the Manage tab > Report Templates screen or as components 
when importing assays/datasets.  

SEARCHING FOR REPORT TEMPLATES 

To search for a report template, enter a few key characters of a report template name or description in the Search 
field and/or expand the Filters area by clicking the down arrow               to specify search criteria. 

As you choose filters (e.g., by selecting Imaging Mode, Channels, Analysis Mode, Category, Shown or Linked By 
Assay options) or enter a Created Between/Modified Between range of dates, the Report Templates List is updated 
automatically to display matching entries.  

Imaging Mode Choose from the following imaging modes: 

BR − Filters for report templates with Brightfield 
BR/FL − Filters for report templates with Brightfield and Fluorescence  

Channels Use the drop-down to select one or more channels to 
be included in the search, then click OK.  

Report templates may include up to six fluorescent 
channels as defined by the associated assay.  
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Analysis Mode Choose from analysis modes that can be associated with a template (e.g., Cell Count, 
Viability, Expression). Analysis modes available for a report template will vary based on 
the imaging mode selected for the template. 

Category Choose from the following categories: 

Unlocked − Filters for report templates that are unlocked and can be edited 
Locked − Filters for report templates that are locked and cannot be edited 
System − Filters for report templates provided by Revvity (locked and cannot 
be edited) 

System report templates are no longer available in the Report Template Library  
provided with the Matrix software but may exist on your system if imported from an 
earlier release. 

Shown Choose from the following Shown states: 

Shown − Filters for report templates selected to appear in Templates drop-downs 
Hidden − Filters for report templates that do not appear in Templates drop-downs  

The Templates drop-downs are available in other screens (e.g., Display Template,  
Export Template and Print Template fields in the Assay Details screen).  

Linked By Assay Choose from the following Linked by Assay states: 

Linked − Filters for report templates that are currently associated with an assay 
Not Linked − Filters for report templates that are not currently associated with an assay  

When saving changes made to a report template linked by other assays, you will be 
prompted with a message indicating that all linked assays will also be updated.  

Report Templates must be unlinked from all assays before they can be deleted.  

Created Between Enter a Created Between range indicating the start/end dates between which to filter  
for report templates created in that time frame. 

Modified Between Enter a Modified Between range indicating the start/end dates between which to filter 
for report templates modified in that time frame. 

If you find it necessary to clear all selected filters and begin the search again, click the Reset button. 

To select a report template and view its details, double-click it in the Report Templates List or click the report 
template once to highlight it and then click the View button located at the bottom of the screen. 
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MAINTAINING THE REPORT TEMPLATES LIST 

When you select a report template, buttons at the top of the Report Templates List become available to perform 
the following functions. The Import button will always be enabled as it does not require the selection of a report 
template in your library. 

Note: If the Matrix 21 CFR Part 11 module is enabled, buttons will only be available for users who have been 
granted permission to perform specific functions. 

Importing Report Templates 

1. While viewing the Report Templates List, click the 
Import button.  

2. Navigate to a folder where an external report  
template library is available or a report template was 
previously saved.  

3. Select one or more .NEXRPT files to be imported.  

4. Click Open. If selected report templates already exist 
in your database, respond to the confirmation prompt  
by clicking Yes to overwrite the file in your system or  
No to abort the import. If you choose No you will be 
prompted to enter a new name under which to import  
the report template (and then click Rename) or click  
Cancel to abort the import. 

Note: When importing a System or Locked report  
template, you will be prompted to import it under a 
different name. Click Yes, enter a new name and click 
Rename to complete the import.  

5. Click OK to acknowledge the successful import and  
confirm that imported report templates are displayed 
in the Report Templates List.  

Exporting Report Templates 

1. Select one or more report templates from the Report 
Templates List to be exported by clicking once to 
highlight the first one and then holding either the Shift 
key (to select a block of templates) or Ctrl key (to 
select non-contiguous templates) down while clicking 
additional report templates.  

2. Click the Export button. 

3. Navigate to a folder where report templates are   
to be saved.  

4. Click OK to save .NEXRPT files in the export location.  
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Renaming Report Templates 

The Rename button will only be available for unlocked 
report templates.  

1. Select the report template to be renamed and click the  
Rename button.  

2. Edit the report template name and click Rename to save  
your changes. 

Deleting Report Templates   

1. Select one or more report templates from the  
Report Template List to be deleted by clicking once to 
highlight the first one and then holding either the Shift 
key (to select a block of templates) or Ctrl key (to 
select non-contiguous templates) down while clicking  
on additional report templates.  

Click the Delete button followed by Yes to confirm the action. If the Matrix 21 CFR Part 11 module is enabled, 
users will be prompted to enter a reason prior to deletion. 

Note: If report template deleted was from the Report Template Library provided with the Matrix software, it 
can be re-imported if necessary. If report template was from a custom library or created using the Matrix 
software, it may be permanently deleted unless report template was 
exported to an external location and saved prior to deletion. 

Report templates must be unlinked from all assays before they can be deleted. 

Showing/Hiding Report Templates in Drop-down 

The Templates drop-down is available in other screens (e.g., Display Template, Export Template and Print 
Template fields in the Assay Details screen).  

1. Select one or more report templates from the Report Templates List to be shown or hidden in the Templates 
drop-down by clicking once to highlight the first one and then holding either the Shift key (to select a block of  
templates) or Ctrl key (to select non-contiguous templates) down while clicking on additional templates.  

2. Click the Show or Hide button depending on whether you want to show/hide the selected report templates in 
the Templates drop-down available in other screens. 
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EDITING A REPORT TEMPLATE 

Editing a report template allows users to customize the overall structure and individual elements used to comprise 
the report, as well as to modify basic Report Template Details (e.g., name, description, imaging mode/number of 
channels, analysis mode and locked state) available on the Save Report Template As screen. 

To select a report template and view its details, double-click it in the Report Templates List or click the report 
template once to highlight it and then click the View button located at the bottom of the screen.  

Report templates can be viewed in two modes − Designer (shown in sample screen above) and Preview (shown in 
sample screen below). Designer mode is displayed by default and allows you to edit template report elements 
while Preview mode displays the final layout of the template and allows you to populate it with sample data.  

While viewing a report template, you can identify if it is locked (representing either a System or Locked template) 
based on whether the Save and Back button is available.   
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Edit the report template as described in each of the sections presented below: 

• Editing Basic Report Template Details, below 
• Editing Report Elements on page 83 

When viewing/editing of a report template is complete, click one of the following buttons to return to the Report 
Templates List, edit defined parameters for the report template or view the template using a selected dataset. 

 
Back Button: Click Back to return to the previous screen without saving any changes. If 
report template has unsaved changes, click OK in response to the confirmation prompt. 

 Save|Save and Back Buttons: Click  to choose between Save (save changes and continue 
editing) or Save and Back (save changes and return to previous screen) and toggle the 
display of buttons. Once desired button is displayed, 
click it to perform the action. 

If a report template is linked by an assay, you will be 
prompted to click Continue as changes saved will 
update all linked assays.  

 Save As|Save As and Back Buttons: Click  to choose between Save As (save template 
with any changes as a copy and continue editing) or Save As and Back (save template with 
changes and return to previous screen) and toggle the display of buttons. Once desired 
button is displayed, click it to perform the action.  

If the report template is locked, this also allows you to copy the template to use as a source 
for creating a new report template. 

See Editing Basic Report Template Details, below for details regarding the Save Template 
As screen. 

 Select Result: Click Select Result to view the report template using a selected dataset. 
Choose a dataset from the displayed list and click Select. Click Preview to view the report 
with the selected data. 

Editing Basic Report Template Details 

When saving a report template (by clicking either the Save and Back or Save As|Save As and Back buttons), you can 
edit the Name, Description, Imaging Mode/Number of Channels, Analysis Mode and Locked state of the template. 

Note: You can only edit a report template if it is unlocked. If the report template is locked or if the report template 
is a Revvity System default, you must first copy the template by clicking the Save As button and entering a new 
name. You can then edit defined parameters for the report template as necessary and click Save to save them as a 
source for a new report template. 
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To edit basic report template details, modify information contained in the following fields. 

Name Displays the name of the report template. Enter a new name or use the drop-down to select a 
template to override. Must be unique. 

Description Displays a brief description which can be used to identify the purpose of the report template. 

Imaging Mode Indicates if Imaging Mode to be associated with the template is Brightfield Only (BR) or 
Brightfield/Fluorescence (BR/FL) including the number of channels. Note that Cellaca MX/ PLX 
instruments support up to 6 channels; Cellometer K2 supports up to 2 channels.  

You can change the number of channels regardless of the previous value. In addition, the 
Imaging Mode selected will populate Analysis Mode field, below with available options.  

Analysis Mode Indicates Analysis Mode to be used for the template. Analysis modes displayed will vary based 
on the selected Imaging Mode.  

See Defining Assay Imaging and Analysis Parameters (For Cellaca MX/PLX) on page 47 or 
Defining Assay Imaging and Analysis Parameters (For Cellometer K2) on page 53 for options. 

Locked Indicates if template is to be Unlocked (to allow editing) or Locked (to prevent editing). 

Click Save to create the new report template and then edit its structure and elements accordingly. Templates can 
only be edited if the Unlocked option was selected for the Locked field.  
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Editing Report Elements 

Report elements can be edited using the Report Designer for WPF application (a third-party plugin by DevExpress). 
See Appendix A. Report Designer for WPF Reference on page 104 for more information about using this application. 

Key report elements are indicated below. 

• The Designer Tab allows you to customize report elements using Designer mode. Features include:  

Report Viewing Pane − Displays layout of elements in the report. Use the horizontal and vertical scroll 
bars to move around in the viewing pane. 

Element Properties − Lists properties of elements that appear in the Report Viewing Pane. Click on an 
element in the viewing page to show its properties.  

Control Toolbox − Allows you to add report controls to the template (e.g., text labels, check boxes, tables, 
etc. as indicated by toolbox icons). Located on the left side of the screen. 

Report Bands − Allows you to customize the report element controlled by the band (i.e., colored boxes 
displayed on the left of the screen such as GroupHeader1, Detail and ReportFooter1 as shown in the 
sample below) by editing its element properties (displayed on the right of the screen). Clicking on a 
specific report band varies the display of element properties.  

• The Preview Tab allows you to view final layout of the report template using Preview mode.  

To add report elements to a template, click on an element in the Control Toolbox and drag it into the viewing pane 
or, click on an element in the viewing pane to reposition it and/or press Delete to remove it from the template. 

To populate a report template with sample data, click the Select Result button located at the bottom of the screen 
to choose a scan result containing appropriate data for the template (i.e., click on the Imaging Mode column to sort 
data and choose a result using the imaging mode for which the template was designed) and click Select.  
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Note: Once scan result data is selected, you may need to toggle between the Designer and Preview tabs to refresh 
the screen and view the data. 

CREATING A NEW REPORT TEMPLATE 

You can create a new report template by clicking the Manage tab > Report Templates option to display the Report 
Templates List and then clicking the Create button located at the bottom of the screen.  

Add report elements and then click the Save and Back button to enter basic Report Template Details such as the 
Name, Description, Imaging Mode/Number of Channels, Analysis Mode and Locked state of the report template.  

Note: Report elements are added using the Report Designer for WPF application by DevExpress. See Appendix A. 
Report Designer for WPF Reference on page 104 for more information about using this application.  

To copy existing report elements to be used as a source for creating a new report template, select a report 
template and view its details by double-clicking it in the Report Templates List or clicking it once to highlight it and 
then clicking the View button located at the bottom of the screen. Click the Save As button and enter a new name 
to save a copy of the report template, and then click the Save button. 

Edit report elements as described in Editing a Report Template on page 80 and click the Save and Back button to 
confirm that the new report template has been saved to the Report Template List.  
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Chapter 10. Using the 21 CFR Part 11 Module 

Functionality described in this chapter is available for users who have purchased a Matrix 21 CFR Part 11 module 
license and had the module enabled by Support. For more information about enabling this module, contact Support 
by visiting https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

FUNCTIONALITY OVERVIEW 

The Matrix 21 CFR Part 11 module is compliant with the Code of Federal Regulations (CFR) Title 21 Part 11 − 
Electronic Records: Electronic Signatures published by the U. S. Food and Drug Administration (FDA). In summary, 
this module ensures that an organization’s use of electronic records and digital signatures in place of traditional 
paper-based documentation is in compliance with current FDA regulations.  

Key elements in Matrix 21 CFR Part 11 module functionality are described below. 

• Electronic Signatures are captured during the counting and analysis workflow using e-Sign/e-Unsign buttons 
and include the name of an authorized user, the date/time when the signature was executed, a reason for the 
action being performed and meaning of the signature (i.e., for the Review, Approval or Rejection of an action). 
If a user’s assigned role does not have permissions to approve count results, a supervisor can log in to e-Sign 
the record on behalf of the user.  

• Electronic Records are created as the result of linking electronic signatures to user actions ensuring that 
records have not been copied or falsified in any manner.  

• An Audit Trail provides assurance regarding the integrity of an electronic record and continually monitors all 
users performing actions, the type of actions performed, and the date/time associated with user actions. 

Audit trails can be retained either Locally on an instrument’s Operating Computer or on a Windows Network 
(i.e., using administrator-controlled access via user roles and privileges). 

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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ESTABLISHING YOUR USER HIERARCHY 

The Matrix 21 CFR Part 11 module requires that you establish a hierarchy of Users within your organization 
consisting of Administrator Users associated with full access to module functionality and other users with varying 
levels of access controlled through the assignment of Roles (i.e., sets of privileges that can be grouped and applied 
to multiple users sharing similar job responsibilities). 

Monitoring User Actions 

To create users and monitor their actions, options are added to the Manage tab for use by Administrator Users − 
Roles, Users and Audit Trail − when the Matrix 21 CFR Part 11 module is enabled.  

As users are created, they are added to the Users List which displays a summary of account details including role, 
personal information (Title and First Name/Last Name), date/time stamp for when the account was created and 
last modified, and whether the account is currently enabled.  

When users log in to the Matrix software to perform daily tasks, the system automatically generates an Audit Trail 
capturing user actions and validates them against the database to ensure integrity of the data is maintained. 
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Controlling User Access via Roles 

Roles allow you to control varying levels of Matrix functionality to which specific groups of users will have access. 
When creating a role, select subsets of privileges that apply to users performing common tasks.  

For example, you can create a basic Technician I role that is able to Create and Read count results but does not 
have access to add an electronic signature to approve those results. To support this basic role, you can create 
advanced roles (Technicians II and III) with the Approval privilege that are able to log in at technician workstations 
using the e-Sign/e-Unsign buttons to approve or reject displayed count results. 

Understanding Role Privileges  

Roles are used in the Matrix 21 CFR Part 11 module to control the following areas of responsibility: 

• Data − Controls whether users can create, manage (i.e., read, update and delete), export/import and 
approve/reject data during the counting and analysis workflow. 

• Settings − Controls whether users can access the Manage tab > Assays, Cell Types and Report Templates 
options allowing them to create, manage (i.e., read, update and delete) and export/import these entitities. 

• Users, Roles or Audits − Controls whether users can access the Manage tab > Users, Roles or Audits options 
(displayed only if the 21 CFR Part 11 module is enabled) allowing them to create or manage (i.e., read, update 
and delete) Matrix software users and roles. In addition, controls whether users can monitor (i.e., read and 
export) the audit trail automatically generated by the system.  
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DATA PRIVILEGES 

The following privileges control whether users can create, manage (i.e., read, update and delete), export/import 
and approve/reject data during the counting and analysis workflow. 

Note: The Data: Read privilege must be selected for the Data tab to be accessible to a user regardless of any other 
Data privileges assigned to that user. 

 

Create Allows users to create a new scan result (i.e., Count and Recount buttons are enabled in the Acquire 
tab > Setup screen) and count results will be displayed under the Data tab. Users must have the Data: 
Read privilege to view scan results in the Data tab > Select screen. 

Read Allows users to view all scan results available under the Data tab and to select a specific scan result 
(i.e., View button is enabled) to be displayed. This privilege must be granted to all users needing to 
view the Data tab > Select screen regardless of any other Data privileges assigned.  

Update Feature not yet implemented. 

Delete Allows users to select a scan result available under the Data tab and delete it (i.e., Delete button is 
enabled) as necessary. Users will be prompted to enter a reason prior to deletion. In addition, this 
privilege enables the Recover Free Space button if users also have sys_admin rights to perform this 
action on the database server. 

Export Allows users to select one or more scan results available under the Data tab and export them (i.e., 
Export button is enabled) to a user-defined location such as the Operating Computer desktop.  

Import Allows users to select one or more scan results stored outside the Matrix software database and 
import them (i.e., Import button is enabled) to be displayed under the Data tab. 

Approval Allows users to add an e-signature (i.e., use of e-Sign and e-Unsign buttons is authorized) for count 
results data currently displayed. If the logged-in user role performing the count does not include this 
privilege, another user with the privilege in their role can log in to e-Sign the record on their behalf.  
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SETTINGS PRIVILEGES 

The following privileges control whether users can access the Manage tab > Assays, Cell Types, ACS Templates and 
Report Templates options allowing them to create, manage (i.e., read, update and delete) and export/import these 
entitities. 

Note: The Settings: Read privilege must be selected for the Manage tab to be accessible to a user regardless of any 
other Settings privileges assigned to that user. 

 
 

 

Create 
 

Allows users to create a new assay, cell type or report template (i.e., Create button is enabled in the 
respective Assays, Cell Types and Report Templates options available under the Manage tab) and 
save the entity (i.e., Save and Back and Save As buttons are enabled).  

Read Allows users to view all assays, cell types or report templates in the respective screens for these 
options available under the Manage tab and to select a specific entity (i.e., View button is enabled) 
to be displayed. This privilege must be granted to all users needing to view the Manage tab > Assays, 
Cell Types and Report Templates screens regardless of any other Settings privileges assigned. 

Update Allows users to modify an assay, cell type or report template in the respective screens for these 
options available under the Manage tab and save their changes (i.e., Save and Back and Save As 
buttons are enabled). The selected entity must be unlocked to allow for editing. Also enables the 
Rename, Show and Hide buttons in the Assays, Cell Types and Report Templates screens. 

Delete Allows users to select an assay, cell type, ACS template or report template in the respective screens 
for these options available under the Manage tab and delete it (i.e., Delete button is enabled) as 
necessary. Users will be prompted to enter a reason prior to deletion. 

Export Allows users to select one or more assays, cell types, ACS templates or report templates in the 
respective screens for these options available under the Manage tab and export them (i.e., Export 
button is enabled) to a user-defined location such as the Operating Computer desktop.  

Import Allows users to select one or more assays, cell types, ACS templates or report templates stored 
outside the Matrix software database and import them (i.e., Import button is enabled) to be 
displayed in the respective screens for these options to be available under the Manage tab. 

 
  



 Chapter 10. Using the 21 CFR Part 11 Module 

8003394 Matrix Software User Manual Rev E  90 

USERS PRIVILEGES 

The following privileges control whether users can access the Manage tab > Users option allowing them to create 
and manage Matrix software users.  

Note: The Users: Read privilege must be selected for the Manage tab > Users option to be accessible to a user 
regardless of any other Users privileges assigned to that user. 

 

Create Allows users to create a new account (i.e., Create button is enabled) to be displayed in the Users List 
and save the account (i.e., Save and Back and Save As buttons are enabled).  

Read Allows users to view all accounts available in the Users List including their assigned roles and to select 
a user (i.e., View button is enabled) to display account details. Passwords will never be displayed. 
This privilege must be granted to all users needing to view the Manage tab > Users screen regardless 
of any other Users privileges assigned. 

Update Allows users to modify an account by assigning a different role, disabling/enabling the account, 
editing personal information (First Name, Last Name and Title) and to save their changes (i.e., Save 
and Back button is enabled). Although the username for an account cannot be changed, users with 
the User: Create, Delete privileges can easily delete accounts and create new ones as necessary. Also 
enables the Enable, Disable and Reset Password buttons in the Manage tab > Users screen. 

Delete Allows users to select an account available in the Users List and delete it (i.e., Delete button is 
enabled) as necessary. 
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ROLES PRIVILEGES 

The following privileges control whether users can access the Manage tab > Roles option allowing them to create 
and manage Matrix software roles. 

Note: The Roles: Read privilege must be selected for the Manage tab > Roles option to be accessible to a user 
regardless of any other Roles privileges assigned to that user.  

 

Create Allows users to create a new role (i.e., Create button is enabled) to be displayed in the Roles List and 
save the role (i.e., Save and Back and Save As buttons are enabled).  

Read Allows users to view all roles available in the Roles List. This privilege must be granted to all users 
needing to view the Manage tab > Roles screen regardless of any other Roles privileges assigned. 

Update Allows users to modify a role by editing the role name, changing privileges selected and to save their 
changes (i.e., Save and Back and Save As buttons are enabled). Renaming a role automatically 
updates the name of the role for all users to which the role has been assigned. Also enables the 
Rename and View buttons in the Manage tab > Roles screen. 

Delete Allows users to select roles available in the Roles List and delete them (i.e., Delete button is enabled) 
as necessary. 

AUDITS PRIVILEGES 

The following privileges control whether users can access the Manage tab > Audit Trail option allowing them to 
search for and monitor the actions of user accounts, and to confirm the Checksum Valid column contains a 
checkmark (      ) for all actions indicating records have not been copied or falsified in any manner. 

Note: The Audits: Read privilege must be selected for the Manage tab > Audit Trail option to be accessible to a 
user regardless of any other Audits privileges assigned to that user.  

 

Read Allows users to view the automatically generated audit log captured by the system and displayed for 
the Audit Trail option under the Manage tab. This privilege must be granted to all users needing to 
view the Manage tab > Audit Trail screen regardless of any other Audits privileges assigned. 

Export Allows users to highlight one or more lines in the audit log and export them (i.e., Export button is 
enabled) to a user-defined location such as the Operating Computer desktop. You must use the 
Validator application that comes with the Matrix software to view the captured data. 

 

 



 Chapter 10. Using the 21 CFR Part 11 Module 

8003394 Matrix Software User Manual Rev E  92 

FIRST-TIME LOGIN AS DEFAULT ADMIN USER 

When logging in to Matrix software for the first-time after the 21 CFR Part 11 module has been enabled, you must 
log in using Default Administrator User credentials to create an Administrator User. Follow the steps listed below. 

Note: If first-time login has already occurred on your system, you will need access to Administrator User credentials 
to create a new Admin User. Skip to Creating an Administrator User on page 93.  

1. From the desktop of the Operating Computer, double-click  
the Matrix icon to launch the software.  

2. Log in as the Default Administrator User by entering  
the username admin and password admin, then click the 
Login button. You will immediately be prompted to create 
a new Administrator User. 

3. Respond to the Create New User dialog by accepting the 
Matrix                     user type option selected by default  
(i.e., creates an Administrator User to reside locally on 
Operating Computer where Matrix software is installed) 
and click the Continue button.  

Note: If your system is connected to a network, you can  
create a Windows Administrator User by clicking the  
Windows user type and selecting a user account in your 
domain to be assigned the Administrator role.  

4. In the Account Information area, enter a username and 
password for the new user. The Administrator role and 
enabled value of Yes will be pre-selected by default. 
For Windows users, this area populates with existing 
username/password. 

5. In the Personal Information area, enter a first name,  
last name and title for your user. For Windows users,  
this area populates with existing First Name/Last Name.  

6. Click Save and Back to create the user. You will 
automatically be logged out of the software upon  
creation of the new user. 

7. To confirm the Default Administrator User was disabled  
upon creation of your new Administrator User, attempt  
to log in again by entering username of admin and  
password of admin, then clicking Login. An error message 
should be displayed. 

8. Log in as your new Administrator User. 

Continue with Managing Roles on page 94. 
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CREATING AN ADMINISTRATOR USER 

If first-time login has already occurred on your system, you must log in using Administrator User credentials (i.e., 
user with Administrator role assigned) to create a new Administrator User. Follow the steps listed below. 

Note: If you have just created an Administrator User using the First-Time Login as Default Admin User section, skip 
to Managing Roles on page 94. 

1. From the desktop of the Operating Computer, double-click  
the Matrix icon to launch the software.  

2. Enter the username and password for an Administrator   
User already created by your organization, then click the 
Login button. 

3. Click the Manage tab in the Navigation Bar on left side 
of the screen and select the Users option.  

4. Click the Create button located at bottom of the screen. 

5. Respond to the Create New User dialog by accepting the  
Matrix                     user type option selected by default 
(i.e., creates an Administrator User to reside locally on  
the Operating Computer where Matrix software is installed) 
and click the Continue button.  

Note: If your system is connected to a network, you can  
create a Windows Administrator User by clicking the  
Windows user type and selecting a user account in your 
domain to be assigned the Administrator role.  

6. In the Account Information area, enter a username and 
password for the user. Select the Administrator role  
from the drop-down and the enabled value of Yes  
(default value). For Windows users, this area populates 
with existing Username/Password.  

7. In the Personal Information area, enter a first name, last 
name and title for the user. For Windows users, this area 
populates with existing First Name/Last Name. 

8. Click Save and Back to create the Administrator User.  

9. Confirm the new user created appears in the Users List.  

10. Click the Logout button and then log in again as your 
new Administrator User.  
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MANAGING ROLES 

Roles allow you to control varying levels of Matrix functionality to which specific groups of users will have access. 
As roles are created, they are added to the Roles List which displays a summary of privileges assigned to the role. 
 
If your user account is associated with Roles privileges (i.e., Roles: Create, Read, Update and Delete), you can create, 
maintain and delete roles containing subsets of functionality to be assigned to users accordingly. Keep in mind that 
the ‘Administrator’ role is a reserved role including full privileges and will not be displayed in the Roles List. 
 
To search for a role, enter a few key characters of a role name in the Search field and/or expand the Filters area to 
specify search criteria (e.g., Created Between or Modified Between start/end dates). As you enter criteria, the Roles 
List will automatically be updated to display matching entries. 

To select a role and view its details, double-click a role entry in the Roles List, or click the role once to highlight it 
and then click the View button located at the bottom of the screen. 

Creating a Role 

1. Click the Manage tab in the Navigation Bar on left side 
of the screen and select the Roles option.  

2. Click the Create button located at bottom of the screen. 

3. Enter a role name (e.g., Technician I) and select privileges 
to be associated with the role (e.g., Data: Create, Read; 
Settings: Read).  

4. Click the Save and Back button and verify that the created 
role appears in the Roles List.  

Note: When a role is selected in the Roles List, the Rename, 
Delete and View buttons become enabled for that role. 

Copying a Role  

1. To create a role based on an existing role, double-click 
the role just created in the Roles List, or click the role  
once to highlight it and then click the View button.  

2. Add and/or remove privileges, as necessary. 

3. Click the Save As button. 
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4. In the dialog box displayed, you can either enter a new  
role name (e.g., Technician II) or select a name from the  
drop-down to override an existing role and click the Save 
button. Verify that the new role appears in the Roles List.  

Renaming a Role 

1. To rename a role, click the role once to highlight it and 
then click the Rename button.  

Note: If you rename a role currently assigned to a user, the 
role name will be automatically updated.  

2. Enter a new role name in the dialog and click Rename.  
Verify that role name has been modified in the Roles List. 

Deleting a Role 

1. To delete a role, click the role once to highlight it and 
then click the Delete button. 

Note: You cannot delete a role currently assigned to a user.  

2. Verify that the role name has been removed from  
the Roles List. 

Guidelines for Managing Roles 

The following guidelines apply when managing 21 CFR Part 11 module roles. 

• The Administrator role (i.e., containing all privileges) is not displayed in the Roles List as it cannot be modified. 
In addition, you cannot create a role with the name “administrator” as it represents a locked role. 

• If a user is granted access to create/update roles (i.e., Roles: Create, Read and/or Update), they will have 
access to assigning ALL privileges regardless of those assigned to their own role. 

• If a user is granted access to create/update users (Users: Create, Read and/or Update), they will have access to 
assigning ALL roles to those users regardless of the role assigned to their own user account. Roles will be 
displayed in the Roles drop-down even if the user does not have Roles: Create, Read and/or Update privileges. 

• You cannot delete a role currently assigned to a user. You must reassign another role to the user before you 
can delete the role. 

• If you rename a role while it is currently assigned to a user, the role name will automatically be updated for all 
users to which the role is assigned.  

• If a role has the Update privilege (i.e., Settings: Update) for assays, cell types and report templates, users 
assigned to this role will only be able to update these entities if the selected assay, cell type or report template 
is unlocked (i.e., the unlocked icon is displayed for the entity). 
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MANAGING USERS 

Users are validated upon login and their actions are tracked as they move through the system via an Audit Trail log. 
As users are created, they are added to the Users List which displays a summary of account details including their 
assigned role, personal information (Title and First Name/Last Name), date/time stamp for when the account was 
created and last modified, and whether the account is currently enabled.  

Note: Only one user may be logged into the Matrix database at a time. However, users can export scan results  
and upload them as files onto an alternate computer for re-analysis of captured images via Data Analysis mode. 
See Data Analysis Mode on page 2 for details. 

If your user account is associated with Users privileges (i.e., Users: Create, Read, Update and Delete), you can 
create, maintain and delete users whose access to Matrix functionality will be controlled by their assigned roles. 
Keep in mind that you must always have at least one active Administrator User for the 21 CFR Part 11 module. 
 
To search for a user, enter a few key characters of a user name in the Search field and/or expand the Filters area to 
specify search criteria (e.g., Roles, Enabled status, or Created Between or Modified Between start/end dates). As 
you enter criteria, the Users List is updated to display matching entries.  

To select a user and view its details, double-click a user entry in the Users List, or click the user once to highlight it 
and then click the View button located at the bottom of the screen. 

Creating a User 

1. Create a new user by selecting the Manage tab >  
Users option.  

2. Click the Create button located at the bottom of the screen.  

3. Respond to the Create New User dialog by accepting the 
Matrix                    user type option selected by default  
(i.e., creates a user to reside locally on the Operating  
Computer where Matrix software is installed) and click the 
Continue button. 

Note: If your system is connected to a network, you can  
create a Windows user by clicking the Windows user 
type and selecting a user account in your domain. 
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4. In the Account Information area, enter a username and 
password for the user. For Windows users, this area 
populates with existing Username/Password.  

Note: Usernames must consist of at least one character 
and passwords are case sensitive. Once a user account is 
created, usernames and passwords cannot be changed  
(i.e., use the Reset Password button for Matrix users).  

5. Select a role from the Role drop-down and ensure that  
the Enabled field is set to Yes.  

6. In the Personal Information area, enter a first name, last  
name and title for the user. For Windows users, this area 
populates with existing First Name/Last Name.  

7. Click the Save and Back button to create the user. 

8. Confirm the new user appears in the Users List. 

Note: When a user is selected in the Users List, the Delete,  
Enable/Disable (based on user status as displayed in the 
Enabled column), Reset Password and View buttons  
become enabled for that user. 

9. Click the Logout button and then log in again as the new user. 

Disabling/Enabling a User 

1. To disable a user, click the user once in the Users List to  
highlight it and then click the Disable button. 

2. Click Yes in response to the confirmation prompt, followed by  
OK to acknowledge the user was disabled. Verify the checkmark 
in the Enabled column is no longer displayed for the user. 

Note: Once a user is disabled, they will not be able to log in. 

3. To enable a user, click the user once in the Users List to  
highlight it and then click the Enable button. 

4. Click Yes in response to the confirmation prompt, followed by  
OK to acknowledge the user was enabled. Verify the checkmark 
in the Enabled column is displayed for the user. 

Resetting a User Password 

Resetting a user password via an Administrative Password Reset is temporary and must be manually relayed to 
that user. Upon the user’s next login with the temporary password, they will immediately be prompted to 
personally reset their password. 

Note: You cannot reset the password for a Windows user as this functionality is controlled by mechanisms 
available in the network. 
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1. To reset a user password, click the user entry once in the Users  
List to highlight it and then click the Reset Password button. 

2. Click Yes in response to the confirmation prompt.  

3. In the Administrative Password Reset dialog, enter a new 
password for the user and confirm the password by entering  
it again. Click the Reset Password button. 

Deleting a User 

1. To delete a user, click the user entry once to highlight it and 
then click the Delete button.  

2. Click OK to acknowledge the user was deleted. Verify the  
user has been removed from the Users List. 

Guidelines for Managing Users 

The following guidelines apply when managing 21 CFR Part 11 module users. 

• Your first-time login to Matrix software after this module has been enabled will be as Default Administrator 
using credentials provided. Upon login, you will be prompted to create a secure Administrator User and as 
part of its creation you will be logged out of the default account. Default Administrator credentials will be 
deactivated at this time. Log in as your newly created Administrator User to establish your user hierarchy. 

• Administrator usernames cannot include “admin” or “administrator” as these represent reserved accounts. 

• You must always have at least one active Administrator User for the 21 CFR Part 11 module.  

• You cannot edit or delete the user account in which you are currently logged in to the system. If you disable 
an account while you are currently logged into it, you will not be able to log in using that account again. An 
exception to this rule exists if you are logged in as the only remaining Administrator User; in this case, you will 
NOT be allowed to disable the account. 

• When clicking the Reset Password button for a user, you are performing an administrative password reset 
which results in the creation of a temporary password that must be manually relayed to the user. Upon the 
user’s next login with the temporary password, they will immediately be prompted to reset the password. 

• For network users, the Reset Password button cannot be selected as this functionality is controlled by 
mechanisms available in the domain. 

Note: Only one user may be logged into the Matrix database at a time. However, users can export scan results  
and upload them as files onto an alternate computer for re-analysis of captured images via Data Analysis mode.  
See Data Analysis Mode on page 2 for details.  
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E-SIGNING COUNT RESULTS 

Electronic Signatures capture the name of authorized users, the date/time when the signature was executed, and 
meaning of the signature (i.e., indicating it was for the Review, Approval or Rejection of an action). Only users with 
the Approval privilege can electronically sign and unsign count results.  

1. Log in as a user with a basic role (e.g., Data: Create,  
Read; Settings: Read) and use the Acquire tab to enter  
setup details and perform a count. Note that Status for 
count result is Not Signed and e-Sign button is enabled.  

2. Click the e-Sign button. Confirm username displayed,  
enter a password and reason for the action, and click the 
e-Sign button again.  

Note: If the user performing a count does not have the 
Approval privilege in their assigned role, the User does  
not have Approval permissions message is displayed.  

3. To log in as a supervisor and sign the count result on  
behalf of another user, enter username and password 
for a user with a role that includes the Approval privilege 
(e.g., Data: Create, Read, Approval; Settings: Create, Read),  
add a reason and click the e-Sign button. Note that Status 
displayed is changed to Signed and e-Unsign button is enabled.  

4. To unsign the count result, click the e-Unsign button, enter 
username and password for a user with a role that includes 
the Approval privilege, add a reason and click the e-Unsign 
button again. Note that Status displayed is changed to 
Unsigned and e-Sign button is enabled. 
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VIEWING AUDIT TRAIL 

The Audit Trail Log provide assurance regarding the integrity of records and must capture the identity of all users 
performing an action, the type of action, and the date/time associated with the action. Audit trails can be retained 
locally on the Operating Computer or on a network. 

Searching the Log 

1.  Click the Manage tab > Audit Trail option. 

2. To search for the actions of specific users, enter a few characters of a user name in the Search field and/or 
expand the Filters area to specify search criteria (e.g., Usernames, Events or Created Between start/end dates). 
As you enter criteria, the Audit Trail is updated to display matching entries.  

3. Review matching entries and ensure that a checkmark appears in the Checksum Valid column for each entry. 

Exporting Log Details 

1. Click the Export button, navigate to an export location on the desktop and click OK to save the audit trail log. A 
YYYYMMDD-HHMMSS-AuditTrail-MATRIX-<user>.AUDITTRAIL file is created, where YYYYMMDD represents 
the current date, HHMMSS is a time stamp (hours, minutes, seconds) and <user> is your username. 

Note: When exporting audit log details, it may be useful to record the total number of action entries in the log 
prior to export (e.g., 1354 as shown in the example below).  

2. From the Windows Applications Menu expand the Nexcelom Bioscience folder and launch the  
Matrix Validator application. 
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3. Click the Browse button to navigate to the exported  
YYYYMMDD-HHMMSS-AuditTrail-MATRIX-<user>.AUDITTRAIL  
file in the saved location.   

 

 

 

4. Double-click the file or click the file once to select it and then click Open to view the exported audit log. 

5. Validate that the total number of action entries currently logged for your system (i.e., 1354 as highlighted in 
the sample screen shown above) matches what you recorded before the export. 

6. To search for the actions of specific users, enter a few characters of a user name in the Search field and/or 
expand the Filters area to specify search criteria (e.g., Usernames, Events or Created Between start/end dates). 
As you enter criteria, the Audit Trail is updated to display matching entries. 
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Chapter 11. Contacting Support  

This chapter presents the scope of Support services and contact methods. In addition, it contains instructions on 
how to report issues to Support and generate diagnostic reports to assist with troubleshooting. 

SCOPE OF SUPPORT SERVICES 

Revvity is dedicated to providing our customers with outstanding support including the following services: 

• Online and in-lab customer training 
• Creation of new cell types 
• Optimization of counting parameters 
• Creation of new report templates 
• Troubleshooting via telephone 
• Periodic safety checks and functional evaluations (offered as part of a separate maintenance contract) 

To inquire about training, visit our website at https://www.revvity.com/contact-us/customer-training and choose 
the Cell Counting and Image Cytometry product. Enter your contact details and any training comments/questions. 

CONTACT METHODS 

If there is a technical issue with your instrument or software, contact Support using the following methods: 

• Visit https://www.revvity.com/contact-us/instrument-support-and-service and choose the Cell Counting and 
Image Cytometry product for support. Enter instrument serial number, name and model, your contact details, 
and a detailed description to report the issue to Support. 

• Visit https://www.revvity.com/contact-us-by-phone to find the global phone number for your area. 

• Send email to CellC-support@revvity.com 

REPORTING AN ISSUE TO SUPPORT 

If a technical issue encountered cannot be resolved using troubleshooting steps provided in your instrument’s user 
manual or the issue persists after rebooting the instrument, perform the following steps before contacting Support 
to report the issue: 

1. Record the error message. 
2. Record the sequence of events leading up to the error, if possible. 
3. If necessary, close the error message window. 
4. Record the Serial Number located on the Device Label for your instrument. 

Gathering these details prior to contacting Support will be helpful as they troubleshoot the technical issue.  
 

https://www.revvity.com/contact-us/customer-training
https://www.revvity.com/contact-us/instrument-support-and-service
https://www.revvity.com/contact-us-by-phone
mailto:CellC-support@revvity.com
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GENERATING DIAGNOSTIC REPORTS 

To generate a diagnostic report that can be emailed to Support when experiencing a technical issue: 

1. Click the Home tab and then the About Matrix button. 

2. Click the Generate Diagnostic Report button followed by OK  
in response to the confirmation prompt. 

3. From the desktop, click the generated Diagnostic_YYYYMMDD.zip  
folder (where YYYYMMDD represents the date on which file was  
generated) to display files in the folder.  

Files in the zipped folder include logs (located in C:\logs\Matrix\vNNN where NNN represents installed version) 
and configuration files (located in C:\ProgramData\Nexcelom Bioscience\Matrix\vNNN\Configurations). 

4. Attach the zipped folder to an email, include the Support Ticket ID (if assigned) in the Subject line and send to: 
CellC-support@revvity.com 

It may be helpful to clear all logs before reproducing the sequence of steps leading up to an issue and/or to reduce 
the size of the diagnostic report to be sent to Support. Logs are generated automatically by your system on a daily 
basis. Keep in mind that clearing all logs will remove accumulated files to date for the version. 

WARNING: Logs may be required to maintain a historical archive. As using the Clear All Logs  
button will permanently remove accumulated logs for the installed Matrix software version, it  
is recommended that you contact IT before clearing logs from your system. 

To clear all logs: 

1. Click the Clear All Logs button. 

Note: It is not recommended to clear all logs unless you are  
confident that they are not being archived by your organization. 

2. When prompted, click Yes to confirm you want to clear all logs. 

3. Click OK to acknowledge that all logs have been cleared.  

 

mailto:CellC-support@revvity.com


 

8003394 Matrix Software User Manual Rev E  105 

Appendix A. Report Designer for WPF Reference 

Revvity uses DevExpress as a third-party plugin for Matrix software reporting capabilities.  

Visit the following page on the DevExpress website for more information about creating Matrix software report 
templates using Report Designer for WPF. 

https://devexpress.github.io/dotnet-eud/interface-elements-for-desktop/articles/report-designer/report-designer-for-wpf.html 

Sample screens displaying the range of topics available for Report Designer for WPF functionality are shown below. 

  

https://devexpress.github.io/dotnet-eud/interface-elements-for-desktop/articles/report-designer/report-designer-for-wpf.html
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Appendix B. Software License Details 

This appendix presents Revvity’s Terms and Conditions related to the use of the Matrix software. In addition, it 
includes a definition of Revvity Proprietary Information. 

TERMS AND CONDITIONS 

The Revvity, Inc. – Terms and Conditions of Sale license agreement states the terms and conditions upon which 
Revvity offers to license to you the software together with all related documentation. The Matrix software is 
licensed to you for use only in conjunction with Revvity’s family of products. 

In addition, the original Matrix software and any subsequent software upgrades installed for your Revvity 
instrument system is protected. You may not tamper with this software (including unauthorized upgrades), 
disclose it to third parties or use it for any purpose other than running your Revvity instrument system. 

Revvity, Inc. does not grant you any other rights to use or disclose the original Matrix software or its upgrades, and 
any further uses will be prosecuted by Revvity to the maximum extent possible by law. Any other use of Matrix 
software or its upgrades is explicitly prohibited. In addition, you may not disclose Matrix software, upgrades, or 
any of its features and benefits to a third party. 

Revvity Proprietary Information 

Cellometer and Cellaca MX products have been developed by Revvity, Inc. and include certain intellectual property 
of Revvity, including without limitation, software, samples, schematics, specifications, manuals, designs, and other 
technical, business, trade secret, proprietary and confidential information provided to Buyer by Revvity (“Revvity 
Proprietary Information”).  

Buyer is granted a non-exclusive right and license to use the Revvity Proprietary Information solely: (a) as 
incorporated into, and in conjunction with, the products, (b) in conformance with the specifications, and (c) for 
Buyer’s internal use.  

Buyer may not: (i) assign, sublicense, transfer, lease, rent or distribute any of its rights in the Revvity Proprietary 
Information; (ii) port, translate, localize or create derivative works based upon the Revvity Proprietary Information 
in any manner; (iii) reverse assemble, decompile, reverse engineer, translate or otherwise attempt to derive or 
obtain the source code, the underlying ideas, algorithms, structure or organization of the Revvity Proprietary 
Information; (iv) use the Revvity Proprietary Information for the benefit of any third party including as part of any 
service bureau, time sharing or third party training arrangement; or (v) publish any benchmark testing results on 
any product or the Revvity Proprietary Information without Revvity’s written consent.  

Revvity, Inc. retains all ownership rights in the Revvity Proprietary Information and, other than limited license set 
forth in this section, Buyer shall have no right in or to the Revvity Proprietary Information.  
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Buyer will not disclose the Revvity Proprietary Information to any third party or use it in any manner outside the 
scope of the license including: (1) developing, designing, manufacturing, engineering, reverse engineering, 
refurbishing, selling or offering for sale items, parts or components of items, derivatives of or equivalents, or  
(2) assisting any third party in any manner to perform such activity.  

Buyer shall use reasonable care to protect the Revvity Proprietary Information, and in no event less than the care 
Buyer uses to protect its own like information.  
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